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I.  Background and objectives 

 

Background and history 

 

A primary goal of vital signs monitoring is to describe long-term trends in ecosystem 

properties to better understand their dynamic nature (Bennett et al., 2005). The Southwest 

Alaska Network (SWAN) has identified several physical and biological processes to 

monitor across all parks in the Network. These processes have been combined into the 

vital sign Landscape Processes and include the following: 

 

1) Onset and freeze-up of ice on large freshwater bodies  

2) Pattern and timing of snow cover  

3) Timing of green-up and senescence in vegetation 

 

The large size and wilderness character of the five park units that comprise the SWAN 

(Alagnak Wild River, Aniakchak National Monument and Preserve, Katmai National 

Park and Preserve, Kenai Fjords National Park, Lake Clark National Park and Preserve) 

limit the feasibility of broad-scale, ground-based measurements.  Common themes 

associated with the monitoring of Landscape Processes are the need for a temporal 

window of days to weeks, the ability to track processes at a large spatial scale across the 

region, and the potential to use remotely sensed data to interpret and integrate these 

processes.  

 

The primary tool to monitor these landscape processes will be multispectral satellite data 

acquired by the Moderate Resolution Imaging Spectroradiometer (MODIS).  Terra 

MODIS and Aqua MODIS view the entire Earth's surface every 1 to 2 days, continuously 

acquiring data in 36 spectral bands at a spatial resolution of 250, 500, and 1000 m.  High 

resolution (15-90m) ancillary data provided by the Advanced Spaceborne Thermal 

Emission and Reflection Radiometer (ASTER) will be available as acquired.  ASTER 

images received to date have already been processed and provided by the USGS Center 
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for Earth Resources Observation and Science (EROS). As such, this protocol does not 

address processing or analysis of ASTER data.  

 

Images derived from MODIS data can be analyzed manually or with algorithms to 

provide information about the landscape processes discussed above. Initial protocol 

development has been accomplished through an Interagency Agreement (IA) with USGS 

EROS.  This protocol documents applications for MODIS data that have been developed 

for the SWAN.   

 

Rationale for monitoring landscape processes 

 

The SWAN Region occupies an area between 57° and 61° N where coastal-temperate and 

boreal systems merge.  Low annual temperature flux, mean annual temperatures ≥ 0 °C, 

and high precipitation characterize the region (Redmond et al. 2005).  Tree-ring 

chronologies and local weather records suggest a temperature increase of roughly 2 °C 

since the 1980s in the Lake Clark region (Driscoll et al. 2005), in agreement with the 

increase in average surface temperatures reported for the northern latitudes during the 

past century (approximately 0.09 °C/decade; ACIA, 2005).  Additional temperature 

increases of approximately 4-7 °C are projected over the next century in the Arctic 

(ACIA, 2005).  Along with decreases in sea ice and land glacier extent, warming over 

terrestrial areas has increased the frequency of mild winter days, resulting in changes in 

the timing of river-ice break-ups, and the frequency and severity of ice dams, floods, and 

low flows (ACIA, 2005).  Observations from remotely sensed data and ground 

measurements in arctic, subarctic and boreal systems have documented such variation in 

the timing of freeze-thaw events (e.g., Kimball et al. 2004a, 2004b) and lake ice 

formation (e.g., Duguay et al. 2003, Wynne and Lillesand 1993), and have indicated 

shifts in plant phenology as a result of lengthened growing seasons (e.g., Delbart et al. 

2005, Beaubien and Hall-Beyer 2003).   

 

Anticipated climate-driven changes in the SWAN include sea-level rise, greater storm 

intensity and frequency, altered seasonal hydrology, accelerated glacial retreat, and 

shorter duration of lake ice cover.  Storage and release of snowpack is pivotal in 

regulating linkages between terrestrial and aquatic systems in the region, and appears to 

play an important role in determining lake ice thickness and the timing of break-up 

(Duguay et al. 2003).  It is unlikely that discrete dates can be identified for ice formation 

and freeze-up, or for snowpack development and loss, as these processes appear to occur 

over a period of days or even weeks.  A more realistic approach may include monitoring 

the timing and duration of these transition periods in the SWAN (e.g., for lake ice 

formation or snowpack development), in addition to the length of the ice- and snow-free 

season.  As with changes in ice formation, changes in snow depth and duration may lead 

to significant shifts in the timing and amount of runoff, and may also strongly influence 

growing season dynamics and net primary productivity. 

 

Widespread increases in indices of vegetation greenness (e.g., normalized difference 

vegetation index (NDVI)) and biomass in northern high latitudes (Myneni et al. 1997, 

2001), as well as an earlier onset of the growing season in northern regions of North 
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America, Asia, and Europe have been observed using satellite-derived measurements 

(Piao et al. 2005, Stockli and Vidale 2004, Hicke et al. 2002).  Early work with Advanced 

Very High Resolution Radiometry (AVHRR) data included the derivation of metrics for 

onset of greenness, time of peak NDVI, rate of senescence, and integrated NDVI (Reed et 

al. 1994).  More recently, MODIS vegetation index data have been used to identify 

transition dates within annual time series, enabling investigators to monitor vegetation 

dynamics at large scales without user-defined thresholds (Zhang et al. 2003).  Using data 

collected from 1982-1998, Hicke et al. (2002) showed peak net primary productivity 

(NDVI) in Alaska and western Canada occurring in late spring and early summer, 

apparently associated with warmer early season temperatures.  Likewise, earlier start-of-

season and/or later end-of-season dates recorded from 1989-2003 appear to have 

contributed to increased growing season length in the Bristol Bay Lowlands and 

Kuskowim Delta, Alaska (Reed, 2006).   

 

Understanding the interactive effects of landscape, climate and disturbance on ecological 

condition is integral to the preservation and protection of public lands, and to determining 

the appropriate management strategies to employ.  Park ecosystems develop and are 

maintained by landscape processes related to climate, geology and hydrology that operate 

over a range of scales and influence the abundance and productivity of plants and 

animals. While natural processes are largely outside the control of natural resource 

managers, understanding these processes provides important ecological context for 

interpreting changes in park resources.  For example, documenting broad-based events 

such as the duration of snow and ice cover is particularly important because extreme 

events can have immediate and long-lasting effects on ecosystems and species. 

Furthermore, monitoring landscape processes may support ecological forecasts that alert 

park managers to future issues of management concern such as the potential for floods or 

wildland fires. 

 

Measurable objectives 

 

Monitoring of landscape processes in the SWAN parks is designed to document changes 

in snow and ice cover and vegetation productivity (NDVI).  Monitoring questions 

identified by the SWAN include the following (Bennett et al. 2005): 

 

  How are onset, duration, and extent of ice cover changing on large lakes in the SWAN 

region? 

  How are timing, location, and duration of snow cover changing in SWAN parks? 

  How are onset, duration and relative biomass of vegetation changing in SWAN parks? 

 

The primary objectives for monitoring are outlined in this protocol:     

 

1) Estimate variability and long-term trends in the timing and duration of lake ice 

formation (freeze-up) and thaw (break-up) in large lakes in the SWAN region. 

2) Estimate variability and long-term trends in the timing and duration of snow cover 

in the SWAN region (establishment of snowpack; snowmelt). 
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3) Estimate variability and long-term trends in growing season NDVI in the SWAN 

region (start- and end-of-season dates; duration of growing season; maximum 

NDVI). 

 

A fourth objective, the estimation of long-term trends in the timing and extent of 

sediment plumes in large freshwater lakes, will not be addressed at this time.  The SWAN 

staff has examined available MODIS surface reflectance images for lake sediment 

plumes and has been unable to interpret ecologically meaningful information.  

 

II. Sampling Design 

 

The best technology currently available to address the SWAN’s landscape processes 

monitoring objectives is MODIS.  The calibration, spatial detail, and geolocation quality 

of MODIS data are significant improvements over its predecessor, AVHRR, which 

provided 4- to 6-band multispectral data at a resolution of 1.1 km.  The combination of 

moderate spatial resolution, high temporal observations, and 100% coverage of the 

SWAN provides a framework of continuous and complete monitoring of the Network 

using the suite of MODIS products.   

 

The MODIS satellite sensor processing system produces data at three spatial resolutions:  

250m, 500m, and 1000m.  The sensor collects 250m resolution data in the visible red and 

near infrared wavelengths, 500m data in the visible, near-infrared, and mid-infrared 

wavelengths and 1000m data from the visible through the thermal infrared wavelengths 

(Table 1).  Because of its wide swath width (2330 km), the MODIS sensor collects near-

global coverage every day, with multiple swaths (usually 2 or 3) over the SWAN.   

 

 

Primary Use Band Bandwidth 

(m) 

Spatial Resolution  

(meters) 

Land/Cloud/Aerosols 

Boundaries 

1 620 - 670 250 

2 841 - 876 250 

Land/Cloud/Aerosols 

Properties 

3 459 - 479 500 

4 545 - 565 500 

5 1230 - 1250 500 

6 1628 - 1652 500 

7 2105 - 2155 500 

Ocean Color/ 

Phytoplankton/ 

Biogeochemistry 

8 405 - 420 1000 

9 438 - 448 1000 

10 483 - 493 1000 

11 526 - 536 1000 

12 546 - 556 1000 

13 662 - 672 1000 

14 673 - 683 1000 

15 743 - 753 1000 

16 862 - 877 1000 

Atmospheric 17 890 - 920 1000 



12/15/06  Satellite-Derived Measures of Landscape Processes 

SOP 1 - Version 1.01 

5 
 

Water Vapor 18 931 - 941 1000 

19 915 - 965 1000 

Surface/Cloud 

Temperature 

20 3.660 - 3.840 1000 

21 3.929 - 3.989 1000 

22 3.929 - 3.989 1000 

23 4.020 - 4.080 1000 

Atmospheric 

Temperature 

24 4.433 - 4.498 1000 

25 4.482 - 4.549 1000 

Cirrus Clouds 

Water Vapor 

26 1.360 - 1.390 1000 

27 6.535 - 6.895 1000 

28 7.175 - 7.475 1000 

Cloud Properties 29 8.400 - 8.700 1000 

Ozone 30 9.580 - 9.880 1000 

Surface/Cloud 

Temperature 

31 10.780 - 11.280 1000 

32 11.770 - 12.270 1000 

Cloud Top 

Altitude 

33 13.185 - 13.485 1000 

34 13.485 - 13.785 1000 

35 13.785 - 14.085 1000 

36 14.085 - 14.385 1000 

 
Table 1.  Spatial and spectral characteristics of MODIS bands and their primary use. 

 

The level of change that can be detected by the sampling being instituted for this protocol 

is a direct result of the temporal and spatial resolution of the various datasets.  The spatial 

extent of any change must be resolved by the satellite.  The spatial accuracy of MODIS 

data is generally said to be approximately 50m, therefore the minimum mapping unit of 

MODIS data is approximately 100m (accounting for possible 50m mis-registration in all 

four directions) plus the base resolution of the MODIS product.  For example, the 

vegetation index data (250m resolution) has a minimum mapping unit of approximately 

350m.  This means that any change that takes place on the landscape must be resolvable 

at 350m spatial resolution.  The change does not have to be 350m in extent to be 

measurable – a significant change (e.g., clearcuts) of less than 350m may impact the 

reflectance characteristics of the pixel sufficiently to influence the satellite 

measurements.  Therefore, we may state that the level of change detectable by this 

sampling method must be resolvable at the spatial resolution of the various products.    

Similarly, we may state that the level of change in the temporal domain is resolvable 

according to the temporal resolution of the various products (Table 2).   

 

Data Set Spatial Resolution Temporal Resolution 

Calibrated Radiance 250m daily 

Snow Cover 500m 8-day and daily 

Vegetation index (NDVI) 250m 16-day 

Phenology measures 

Start of Growing Season 250m Annual 

End of Growing Season 250m Annual 

Duration of Growing Season 250m Annual 
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Peak Growing Season 250m Annual 

Seasonally Integrated NDVI 250m Annual 
 

Table 2.  Spatial and Temporal characteristics of SWAN MODIS data products. 

 

 

MODIS data and data products are distributed by the EROS Land Processes Distributed 

Active Archive Center (LP DAAC), the Level 1 and Atmosphere Archive and 

Distribution System (LAADS), and by the National Snow and Ice Data Center (NSIDC) 

DAAC.  The land processes MODIS data set includes 9 primary products (e.g., 

vegetation index (VI), surface reflectance, etc.) that are produced at a variety of spatial 

resolutions and temporal frequencies to yield over 40 land-related products.  

 

The calibrated spectral radiance data are available through the LAADS, and require 

associated Geolocation files (also available from LAADS) for georeferencing the data 

sets (see SOP 4).  Surface reflectance products were carefully evaluated for lake ice 

metrics and found to be unsuitable due to problems with patches of missing data, the 

aerosol corrections and between-path mosaicking anomalies. 

 

The daily stitched products are further processed into temporal composites of 8 days or 

16 days in order to reduce the effects of cloud cover and to reduce the data volume that 

would quickly become overwhelming with daily products.  The data are processed into 

higher level products using a variety of algorithms that have been vetted and extensively 

reviewed by the scientific community.  The MODIS products that are being supplied as 

baseline datasets to the SWAN and their spatial and temporal resolutions are given in 

Table 2.  The snow data set is provided as both 8-day composites (corresponding to 

maximum snow extent during the 8-day period) and daily snow extents at 500m 

resolution; the vegetation index product is provided as 16-day composites and 250m 

spatial resolution.   

 

The phenology products are derived from the 250m VI data.  Any use of the general “VI” 

term is in reference to the MODIS product which contains both a NDVI and an Enhanced 

Vegetation Index (EVI) product.  In reference to the standard “VI” product for this 

protocol, NDVI will be used.  These phenology data are supplied as annual summaries 

(i.e., one summary value for each of the phenology metrics for each year).  The products 

are produced in units appropriate for each metric they represent: i.e., the start and end of 

season metrics are expressed as Julian date, duration of growing season is expressed as 

number of days, and seasonally integrated NDVI is expressed in daily accumulated 

NDVI units (Table 2).  

 

 

III. Data Acquisition, Processing and Analysis 

 

In this portion of the narrative, the procedures for data acquisition, processing, and 

analysis will be discussed.  Figure 1 provides a graphical representation of these 

procedures.  The primary goal is to streamline the procedures for acquiring MODIS data 
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from the LP DAAC, NSIDC and LAADS in addition to providing scripted methods for 

processing data into a usable format.   

 

 

 

 
 
Figure 1.  Flowchart of data acquisition, processing, analysis and interpretation for standard MODIS 

products.  Yellow boxes represent procedures that are further described in the SOPs.  The arrow 

between data analysis and data interpretation represents the analytical nature of these procedures.  

 

 

The set of software that is required for the data processing and analysis consists of image 

processing, geographic information system, special-purpose free software provided by 

USGS, graphics software, and a spreadsheet or database (Table 3).  In addition, a set of 

scripts are also required to run certain routines in the processing stages of the protocol.  

Table 3 lists the required software, the general application of the software and the SOP 

for which it is used.  

 

 

Software Application SOP 
ENVI Image processing 2,3,4 

IDL Image analysis 2 

ArcMap Multiple data layer analysis 3 
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MODIS reprojection tool 

(MRT) 

Image reprojection 2,3 

MRT-Swath Image reprojection 4 

Excel Data summary and 

reporting 

2,3,4 

ftp Data transfer 2,3,4 

Photoshop Image enhancement 4 

VI-processing script Image processing 2 

Snow (daily) processing 

script 

Image processing 3 

Snow (8-day) processing 

script 

Image processing 3 

 
Table 3.  Software requirements for the Landscape Processes Protocol. 

 

 

Data Acquisition 

 

In addition to the baseline historical data sets that have been provided to the SWAN, 

three primary MODIS data sets are to be operationally acquired for monitoring of SWAN 

vital signs.  These include the following:  

 

 MODIS calibrated radiance from LAADS  

 MODIS Normalized Difference Vegetation Index (NDVI) from LP DAAC  

 MODIS snow cover extent from NSIDC DAAC 

 

Both the LP DAAC and NSIDC DAAC have ‘data pools,’ or repositories of gridded 

MODIS data that are accessible via standard File Transfer Protocol (FTP).  Calibrated 

radiance data for SWAN are selected and downloaded via FTP from the LAADS website 

at NASA Goddard.   

 

The individual SOPs (SOP 2-4) provide further detail for each product type.  

 

Data Processing 

 

The files downloaded from each of the archive centers will appear as discrete tiles of 

data. The tile reference system is simply the row (vertical) and column (horizontal) 

number of the tile within the scheme. Coverage of the SWAN requires six tiles; h09v02, 

h09v03, h10v02, h10v03, h11v02, h11v03.  The tile locations are shown in Figure 2. 

   

Each data tile is provided in HDF-EOS format and is in the Sinusoidal projection.  Since 

HDF-EOS is uncommon in many off-the-shelf image processing/geographic information 

system (GIS) packages and the Sinusoidal map projection severely distorts the SWAN, 

we have incorporated processing protocols that convert these tiled data to a single 

GeoTIFF image file in the Alaska Albers Equal Area Projection (Appendix 1).   
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Figure 2.  Horizontal/Vertical tile locations for coverage of the SWAN.    

 

 

In the case of the NDVI and snow cover data, once the data tiles have been downloaded 

from the appropriate DAAC location, NPS personnel run a simple executable 

(List_HDF.exe) to create a text file containing the full set of HDF tile names for each 

composite period.  The output text files are named using the four-digit year and three-

digit Julian date corresponding to the first day of the composite period (i.e. 2006001.txt, 

2006009.txt, etc.).  This HDF-EOS file list is used as an input to the data processing 

scripts. 

 

The processing scripts utilize the MODIS Reprojection Tool (MRT), which was 

developed by the LP DAAC to address issues related to data format and projection.  The 

MRT can mosaic, subset, reproject, and reformat the raw HDF-EOS tiles in a single 

process.  It can be executed using either a graphical user interface (GUI) or directly from 

the command line.  

 

For the SWAN, batch file scripts have been developed that will execute the mosaic and 

resample commands within the MRT command line structure.  These commands require 

that two input files exist; a list of raw MODIS tiles for processing and a parameter file 

that describes the spatial subset, projection, and output format.  Parameter files for each 

composite period through 2008 have been provided for each of the MODIS products. 

 

When data have been downloaded from the respective data pools, NPS personnel need 

only run the list executable described above to create the input text file and then execute 

the product batch file to create consistently processed time-series collections of MODIS 

NDVI and snow cover data sets. 
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The daily calibrated radiance data will utilize the MRT Swath tool for processing the 

MOD02 calibrated radiance HDFs and their corresponding MOD03 geolocation files into 

two single band files.  The methods for processing these data using the MRT Swath GUI 

are further described in SOP 4 of this protocol. 

 

Data Analysis 

 

While there are proven methods for monitoring landscape processes using vegetation 

index data, the analysis of other data sets for SWAN vital sign monitoring will be largely 

exploratory in the initial phase of protocol implementation.  Hence, we provide detail of 

the methods used for time-series analysis of the vegetation index data (SOP2) and present 

suggested analysis techniques using the calibrated radiance and snow cover data sets. 

 

Calibrated Radiance.  Analysis of calibrated radiance data will largely be through 

manual interpretation of natural color and/or color infrared composited imagery for the 

assessment of metrics such as lake ice formation and break-up and duration of freeze-up 

and break-up seasons, (SOP 4).  Periodic digital calibration will standardize the 

interpreters to the images and each other. 

 

Normalized Difference Vegetation Index.  The MODIS vegetation index data that have 

been collected for the SWAN provide a unique opportunity to study changes in 

vegetation phenology over time.  A variety of methods for using time-series NDVI data 

have been developed to extract critical phenology metrics such as the start of the growing 

season (SOS), time of peak greenness, end of growing season (EOS), and duration of 

growing season (DOS).  The derivation of such parameters through time allows for the 

comparison of trends in the timing and magnitude of such events.  The SWAN will use 

methods identified by Reed et al. (2003) to calculate annual summaries of phenology 

metrics.   Analysis techniques for phenology metrics and annual reporting of vegetation 

trends are further described in SOP 2. 

 

Snow Cover.  The MODIS snow cover product will be used primarily as a measure of 

the on/off period throughout the Network.  This product does not provide a measure of 

snow depth, but rather a maximum extent of snow covered area within an 8-day 

composite period or on a daily basis.  These data have been used successfully to monitor 

snow cover accumulation and depletion across large areas.  For the SWAN, it is useful to 

quantify the presence of snow in terms of a zone (ecoregion) which can be compared 

from year to year.  We will use a simple ecoregion analysis, conducted within a GIS 

framework, to provide percent cover for every 8-day period (SOP 3).  Where more 

temporal detail is needed, daily snow cover data can be used. 

 

IV. Data Management  

 

Data management will be a critical component of this protocol as both data volume and 

data diversity will be significant issues.  Data management will be required at two levels; 

operational and archival.  Operational data management includes the routine acquisition 
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and processing of MODIS data and handling the subsequent data analysis.  Archival data 

management includes handling the databases that will serve as baselines for vital sign 

monitoring and the long-term data sets that are created during analysis procedures.  

 

Operational Data Management.   

 

The priority operational data management is to organize the pertinent data products for 

transfer to the archival data management.  Secondary concerns will include handling the 

raw data products from the LP DAAC, NSIDC DAAC, and LAADS, efficient, yet 

conservative management of temporary files, production and storage of analysis files, and 

deletion of temporary files.  The operational data management will be the responsibility 

of the research ecologists and will include ongoing communication and revision to the 

process with the data management specialist. 

 

The operational data management will include the following steps: 

1) downloading of data from LP DAAC, NSIDC DAAC, and LAADS 

2) implementing the standard data processing scripts 

3) implementing non-standard data processing (as needed) 

4) conducting data analysis 

5) transferring the archival data to data manager 

 

As the operational data management will be conducted in a PC environment, a suggested 

organizational structure for operational data management follows.  It is assumed that the 

primary disk drive will be D:\ in this example:  

 

D:\SWAN\MODIS_CalRad\yyyy 

D:\SWAN\MODIS_VI_16day\yyyy 

D:\SWAN\MODIS_Phenology\yyyy 

D:\SWAN\MODIS_SNOW_8day\yyyy 

D:\SWAN\MODIS_SNOW_daily\yyyy 

 

where yyyy is the year the data are collected.  Each of these file folders is where the 

primary data processing will take place.  The standard processing will take place 

approximately every month.  Under normal conditions, the set of processes should be 

completed in two to three days.   

 

Because a number of ancillary files are necessary for the routine processing of the snow 

and vegetation index products, files with the following file extensions will be present 

within each of the file folders listed above: 

 

*.txt text documents containing file names for input to data processing scripts 

*.prm parameter files that are necessary for reprojecting files 

*.tif output image files that are to be placed into the data management archive 

 

These files should be maintained in the operational system, but only the *.tif files should 

be delivered to archival data management. 
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As mentioned earlier, in addition to the routine data processing, the research ecologists 

will be conducting exploratory analysis on a regular basis that should not involve data 

that are housed in the file folders listed above.  A conservative data management 

structure that does not endanger any of the routinely processed files is recommended.  

Therefore for the exploratory data analysis, the following parallel file structure is 

suggested: 

 

D:\SWAN\Analysis\ MODIS_CalRad\yyyy 

D:\SWAN\Analysis\MODIS_VI_16day\yyyy 

D:\SWAN\Analysis\MODIS_Phenology\yyyy 

D:\SWAN\AnalysisMODIS_SNOW_8day\yyyy  

D:\SWAN\Analysis\MODIS_SNOW_daily\yyyy 

 

Archival Data Management.   

 

Archival data management will be required on all the baseline (standard) data sets and 

those data sets resulting from analysis procedures that merit promotion from operational 

to archival status.  A data set consisting of processed MODIS products has been provided 

to serve as the original baseline data dating from February, 2000.  The existing data set 

and projected data volumes are approximately as shown below in Table 4:  

 

 

Existing Data Set (2000-present) Size (Gb) 

Calibrated Radiance 88.0 

Vegetation Index (NDVI) 7.8 

Phenology metrics 0.6 

Snow Cover 8-day & Daily 7.5 

Total 97.0  

 

Projected Annual Increase Size (Gb) 
Calibrated Radiance 13.0 

Vegetation Index (NDVI) 0.9 

Phenology metrics 0.1 

Snow Cover 8-day & Daily 1.1 

Supplemental satellite data, inc 

ASTER 

5.0 

Total ≥20.0 

  
Table 4.  Existing and projected data volumes for SWAN MODIS and ASTER products.  

 

There will be an estimated increase in data volume of 15-20 gigabytes per year.  In 

addition to the basic data sets, there will be supplemental satellite data collected for 

augmenting this information.  The supplemental data could include high resolution 

imagery (e.g., ASTER) that could be helpful in interpreting details that may not be 

discernible on the MODIS imagery.  Additional data sets will also result from data 
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analysis applications.  These supplementary data sets may result in an additional 5 

gigabytes per year. 

 

The completed data products will be stored long-term as read-only files on the Alaska 

Regional central data file server. These data will be jointly managed by the SWAN data 

manager and the Alaska Regional Office (AKRO) GIS staff and will adhere to the AKRO 

GIS requirements. These data will be available to Alaska NPS staff by using the ArcGIS 

Theme Manager or by direct access to the data file server.  The National Park Service 

does not have the capability to post data sets of this size on the Internet at this time.  

Public access to these files will be by special request.  Metadata for available products 

will be posted on the NR-GIS Clearinghouse. 

 

Draft or interim data will be stored short-term on the SWAN Team data file server and 

will be read-write accessible to SWAN staff. These data include files that are originally 

downloaded or temporary files used to generate the final data products. These should be 

removed when the final data products are completed. 

 

Backup procedures for these data sets should follow the National Park Service’s normal 

procedures.  Backups are managed by the Alaska Regional Information Technology staff 

as described in the SWAN Data Management Plan, Section 11.5.  

 

Documentation 

 

One metadata record per image type will be produced and will meet the Federal 

Geographic Data Committee (FGDC) Content Standards for Digital Geospatial Metadata 

(CSDGM). The metadata records should cite this protocol in the ‘Larger Work Citation’ 

field.  An example metadata file is shown in Appendix 2. 

 

Quality Assurance/Quality Control and Validation 

 

Quality assurance and control is a major element of the original MODIS product 

development (before the Landscape Processes Protocol is implemented).  For a summary 

of the types of processing QA/QC that have been implemented, see an overview of the 

Land Data Operational Product Evaluation (http://landweb.nascom.nasa.gov/cgi-
bin/QA_WWW/newPage.cgi).  Similarly, many of the standard MODIS products have 

undergone validation experiments.  The MODIS Land Processes Validation web site 

summarizes many of these efforts (http://landval.gsfc.nasa.gov/index.php). 

 

V.  Analysis and Reporting 

 

This portion of the narrative includes descriptions of analysis techniques and products for 

the lake ice, snow cover and for the NDVI derived phenology metrics.   It also provides 

examples of products that may be useful in annual reporting of vital signs monitoring.   

 

Lake Ice 

 

http://landweb.nascom.nasa.gov/cgi-bin/QA_WWW/newPage.cgi
http://landweb.nascom.nasa.gov/cgi-bin/QA_WWW/newPage.cgi
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SWAN is located in an extremely dynamic region of Alaska, where maritime and 

continental climate regimes meet.  Climatic patterns are exacerbated by topographic relief 

and peninsulas that extend into the North Pacific Ocean and Bering Sea.  Ice metrics on 

large lakes and lake complexes are indicators of the cumulative thermal regime across 

SWAN (Jeffries et al, 2005).  A warming climatic trend should lead to shorter ice-bound 

seasons on lakes, while overall colder climate will lead to longer ice seasons.  These 

trends will likely vary spatially across SWAN and be reflected in different lakes.  The 

objective of this protocol is to determine the natural variability in ice season in SWAN 

and detect long term trends in ice season duration and freeze-up/break-up dates. 

 

Lake ice metrics are interpreted from daily MODIS Calibrated Radiance (MOD02) 

images.  Lake ice metrics are break-up date, freeze-up date and duration of ice season, 

break-up season and freeze-up season.  Seventeen lakes and lake systems are selected for 

interpretation of ice cover.  Each daily image is examined and the ice cover estimated and 

recorded.   Calibrated radiance data are available early in the processing stream, so have 

no atmospheric corrections.  As such, they can not be automatically compared between 

dates.  Manual interpretation of calibrated images is used to derive the ice season metrics.  

Digital calibration is used to standardize ocular estimates through time and between 

interpreters.   

 

Freeze-up date is when ice cover is >90%.  Break-up date is when ice cover is <10%.  Ice 

season is the number of days between freeze-up and break-up (Jeffries et al, in press).  

Number of days for break-up season and freeze-up seasons are also recorded.   Annual 

reporting will consist of a chronology of lake ice events and processes (dates of onset, 

freeze-up and duration).   

 

The long term record will be analyzed to determine if there are trends in dates and 

duration of ice events.  Preliminary interpretations of the MODIS data suggest that 

landscape-scale phenomena across the SWAN are complex.  For example, large lakes 

vary in their timing and rate of freezing and often do not have single freeze-up or break-

up events. Some lakes freeze early in the season and remain frozen until late in the 

spring, when they break-up very rapidly (Fig. 3).  For these lakes, break-up dates have 

been surprisingly consistent across years (2001-2006).  Other lakes are much more 

variable, and in some years do not freeze at all.  

 

 
 
Below (L – R):  MODIS time series of mid May 2001-2003 for the Alaska Peninsula 
from Lake Clark south to Becharof.  Rapidfire images. 

Below (L-R):  MODIS time series of breakup of lake ice on Lake Iliamna, April 15 - 
May 10, 2005.  (1) April 15; (2) April 17; (3) May 8; (4) May 10.  Rapidfire images. 

(1) (2) (3) (4) 
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Figure 3.  Timing of lake ice breakup for Lake Iliamna and interannual variation of ice cover for 

Lake Clark. 

 

Vegetation Index 

 

A major utility of the vegetation index time series is the ability to measure seasonal 

vegetation dynamics (Fig. 4).  Phenology metrics of start of season (SOS), end of season 

(EOS), duration of the season, time of maximum NDVI, value at maximum NDVI, and 

total growing season NDVI were provided to the SWAN for the years 2000-2005.  As 

part of the operational processing stream, the SWAN will acquire 16-day composites of 

vegetation index data throughout the year.  Once a full year has been acquired, the new 

data will be added to the vegetation time series and phenology metrics will be derived for 

the additional year. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 4.  NDVI image (left) and the profile for a single year (right), illustrating derived phenology 

metrics. 

 

May 17, May 12, May 16, 
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Figure 5.  Trend analysis of the AVHRR time series of North America shows both increasing (green) 

and decreasing (red) trends in growing season NDVI in Alaska during the years 1982 – 2003 (1).  

Decreasing productivity was localized to a single boreal ecoregion (2) and the areas of decrease 

coincide with defoliation or forest mortality (3).  

 

The results of the phenology analysis will be evaluated for each of the primary vegetation 

communities in cooperation with network ecologists.  As the length of the temporal 

profiles of vegetation dynamics increase, they provide the opportunity to analyze trends 

in vegetation phenology patterns over time.  Figure 5 shows an example of trends in 

growing season greenness for Alaska using coarse spatial resolution high temporal 

resolution data acquired from AVHRR.  The areas in red indicate a trend toward reduced 

growing season greenness, while the areas in green are indicative of increasing greenness 

trends during the same period (1982- 2003).   

 

The trend analysis technique applies a best-fit line to the phenology metric data and 

performs a simple t-test to determine if the slope of the line is significantly different from 

0.  Slopes that are significantly greater than 0 indicate an increasing trend, while slopes 

significantly less than 0 represent a decreasing trend.  While this type of analysis is 

typically used for looking at medium- to long-term trends in vegetation dynamics (> 10 

years), annual reporting will be limited to the mapping of annual phenology metrics (Fig. 

6), and/or the plotting of time series for SOS, EOS, etc., for visual comparison with 

previous years (SOP 2). 
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Figure 6.  Time of start of season image, 2004; White = no growing season, purple = SOS in March, 

light green = SOS from April 1-15, dark green = SOS from April 16-30, orange = SOS in May, and 

red = SOS in June. 

 

 

 

Snow Cover 

 

MODIS provides a standard measure for monitoring the extent of snow covered area 

within the SWAN via both daily and 8-day composite snow products.  The snow cover 

products are created by applying a normalized difference snow index (NDSI) algorithm 

to the surface reflectance.  The result is a classified image that allows the analyst to 

identify incremental changes in snow cover throughout the region as well as quantify the 

snow covered area within a given zone. 

 

The snow cover data is available approximately 3 – 4 days after the close of the 

composite period, allowing timely measures of snow cover over large areas.  Visual 

analysis of snow patterns, such as those seen in Figure 7, can be compared with previous 

years to identify anomalous snow conditions.  As with the NDVI product, ancillary data 

(e.g., from SWAN weather stations) has the potential to greatly inform monitoring efforts 

with MODIS. 
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Figure 7.  Eight-day MODIS snow cover extent image for 1-8 May 2005.  The major classification 

categories and the SWAN park boundaries are mapped. 

 

A more quantitative measure of the snow cover extent can be derived using a zonal 

coverage for time series analysis of snow covered area.  The defined zone could represent 

an ecoregion, drainage basin, park or some other delineation for which snow covered area 

would be a meaningful metric.  Here, we will summarize snow duration and extent by 

ecoregion (Nowacki et al, 2002) using the 8-day snow cover composites.  Standard snow 

cover accumulation/depletion curves relate the percent of a basin or zone that is covered 

by snow to elapsed time during both the snow accumulation and snow melt seasons.  

Such curves help provide an indication of the temporal and spatial extent of seasonal 

snow pack and its potential impact on water resources.  A steep decrease in snow-covered 

area can be indicative of either shallow snow pack or high melt rates.  On the other hand, 

a slow decrease results from either a deep snow cover or slow melt rates most likely due 

to low temperatures.  Plotting snow cover versus growing degree days can help reduce 

this ambiguity, however this would require additional climate data inputs, such as those 

from the new SWAN weather stations.  Curves measuring the maximum extent of snow 

cover as a function of time without regard to air temperature can still be very useful in the 

assessment of snow covered area.   

 

The time series plot shown in Figure 8 illustrates the comparison of 2004-05 snow cover 

with the previous year as well as a short term average condition calculated using 4 years 

of MODIS snow data.  The plot illustrates that while the onset of the snow season in this 

area was later than the comparison periods, the duration of cover was longer, the spatial 
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extent of cover was greater, and the time of depletion was later, indicating an abundant 

supply of melt water in the spring. 

 

 
Figure 8.  Example of a snow accumulation/depletion summary. 

 

As a supplement to the 8-day composite data, daily snow cover imagery can be used to 

more precisely measure the timing of snow cover events given cloud free acquisitions.  

Another use of the daily images for analysis of annual snow cover conditions will be to 

create daily time series of snow cover for each year and assess temporal patterns using 

the z-profile plotting functions in ENVI.  The procedures and applications of this type of 

analysis are further described in SOP 3. 

 

Reporting 

 

Communication of monitoring results will occur through annual summary reports and 

informal meetings with park managers, and through multi-year synthesis reports.  Annual 

reporting will consist of a chronology of lake ice (dates of onset, break-up, and duration), 

snow cover (dates of first measurable snowfall, establishment of permanent snowpack, 

beginning of melt, end of melt) and productivity metrics (dates for start and end of 

season, maximum NDVI, integrated NDVI) for selected study areas.  In addition, spatial 

variation in these metrics will be recorded (e.g., extent of snow cover) and a range of 

values provided for each metric across the Network (e.g., variation in date of lake ice 

onset across the Network).  Any observed anomalies, or any conditions that may 

confound interpretation of the data, will be recorded.  Changes to the protocol will 

likewise be documented.  Synthesis reports could include results of time-series analyses, 

graphical representation of selected metrics (e.g., Fig. 6), and/or mapped regions of 

change (e.g., areas experiencing a shorter or longer growing season (Fig. 5), or earlier or 
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later onset of lake ice).  Table 5 outlines metrics that will be included in annual and 

multi-year reports. 

 

Ancillary data used during data analysis and interpretation and verification may include 

SWAN climate/temperature records (e.g, Harding Icefield Weather Station), lake ice 

records (e.g., X:\Libraries\Database_Water\SWAN\AK_Lake_Ice_Monitor_History), 

historic accounts and journals, and informal reports from park pilots and backcountry 

rangers. Guidelines for formatting annual summary and 10-year synthesis reports are as 

follows: 

 

http://www.nature.nps.gov/im/units/swan/Libraries/Data_Management/DataManageGuid

elines/SWAN_ReportAnnualFinalSpec_0412.pdf 

 

Vital sign Metrics 

Lake ice For a given lake: 

 date of initial freeze-up  

 date of final freeze-up - continuous ice 

 date of initial break-up 

 end of break-up – ice-free 

 duration of break-up season 

 duration of ice season 

 duration of freeze-up season 

 duration of ice-free season 

 range of break-up and freeze-up dates, 

seasonal durations across SWAN region 

Snow cover For a given study area or ecoregion: 

 date of first measurable snow cover 

 date of snowpack establishment – onset 

 date of first measurable snow melt 

 end of snow melt – snow-free 

Across SWAN: 

 maximum extent of snow cover (mapped) 

 range of snow onset and melt dates across 

study areas 

Productivity For a given study area or ecoregion: 

 date of first measurable NDVI - onset 

 date of decline in NDVI – senescence 

 maximum NDVI 

 integrated NDVI 

 duration of growing season 

Across SWAN: 

 range of onset and senescence dates across 

study areas 
 

Table 5.  Reporting summary for landscape processes vital signs. 
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VI.   Personnel Requirements and Training 

 

The implementation of this protocol (Table 6) requires a diverse skill set including 

expertise in remote sensing, geographic information systems, data management, and 

landscape ecology (Table 7).  Although the levels of expertise required for the continuity 

of the protocol vary, a high level of competence is necessary to build the protocol and 

standard operating procedures and maintain them through the initial stages of the project. 

After the procedures have been successfully operating, the level of expertise required in 

remote sensing, geographic information systems, and data management will be reduced.  

However, an ongoing high level of expertise by ecologists will be required throughout the 

duration of this protocol, as data interpretation cannot be completely automated.   

 

Task Personnel 

Data acquisition: 

 -Routine downloads 

 -Automated preprocessing 

Data Technician 

Data processing: 

 -Custom processing, enhancements 

Ecologist or Remote Sensing Specialist 

Data analysis and interpretation: 

 -Manual interpretation of metrics 

 -Manual or automated determination of 

metrics 

 -Spatial analyses 

 -Trend analyses 

 -Data summaries 

Ecologist, with assistance from GIS 

Specialists, Remote Sensing Specialist, and 

Statistician 

 

Reporting Ecologist 

Data management: 

 -Copy new files to Central Data Server  

-Manage data formats, directory structure, 

archiving 

-Maintain consistent data characteristics 

and software compatibility with other 

SWAN data sets 

Data Manager, GIS Specialist, and 

Ecologist 

Backups All Users (local) and AKRO IT staff 

(archives) 

Minor protocol revisions and 

documentation 

Remote Sensing Specialist and/or Ecologist 

Development of alternative processing 

scenarios: major protocol revisions 

USGS-EROS staff or similar expertise 

 
Table 6.  Work flow and responsibilities for monitoring of landscape processes. 

 

Data downloads and processing will need to be accomplished at least monthly before the 

data are deleted from the LP DAAC and LAADS data pools.  These tasks will require a 

minimum of 3-4 days/month.  Interpretation of the images will be conducted annually.  
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The analysis, interpretation and reporting phases of these SOPs will require 

approximately 0.5 FTE by the ecologists and remote sensing/GIS specialists combined. 

 

 

Personnel Qualifications/Experience 

Data Manager  Experience with data stewardship and 

developing applications for data analysis 

Remote Sensing Analyst  Extensive experience with MODIS 

products and specialized software 

(MODExtract, MODIS Reprojection Tool 

(MRT), MODIS quality assurance tool - 

Land Data Operational Product 

Evaluation (LDOPE)) 

 Experience with image processing, 

including ENVI software 

 Experience in regional-scale remote 

sensing applications 

 Experience in deriving phenological 

metrics 

 Experience with time-series analysis 

GIS Specialist/Analyst  Experience in assembling data sets with 

disparate characteristics (e.g., 

raster/vector, map projections, data 

formats) and harmonizing them 

Ecologist/Analyst  Familiarity with SWAN landscapes and 

landscape processes, including field 

experience 

 Experience in manual interpretation of 

satellite imagery and derived products 

 Ability to synthesize information from 

multiple data sets to develop summary 

reports of short- and long-term variation 

in phenological metrics 

Data Technician  Experience with GIS and data 

management 

 
Table 7.  Personnel qualifications for monitoring of landscape processes. 

 

 

Training procedures.   

 

All personnel involved in this protocol should receive training in ArcGIS and ENVI 

software on a one to two year schedule.  
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VII. Operational Requirements 

 

Workload /Acquisition Schedule 

 

Because these data are ingested and stored at their respective archive centers, the timing 

of data collection is not as crucial as in field based protocols.  Nevertheless, maintenance 

of an up-to-date archive of SWAN data sets will require adherence to a regular download 

and processing schedule.   

 

Calibrated Radiance data are continuously maintained and available from the LAADS 

web site.  Vegetation index data remain staged on the LP DAAC data pool for up to one 

year.  On occasion, these data are removed from the data pool prematurely, but always 

remain available via the EOS Data Gateway (EDG).  In the case of the snow cover data, 

the NSIDC DAAC maintains a complete archive of 8-day and daily data in their data 

pool.  As with data via the LP DAAC, if these would be removed from the data pool, they 

are always accessible through the EDG.   

 

Table 8 shows the composite period length and the number of days, after the close of the 

composite period, when products are typically available for download.  Downloading will 

take place at least monthly - well before the data are deleted from the data pools.  If 

analysts miss several periods and the data are no longer available in the data pool, they 

can be retrieved from the EDC Archive or LAADS using the procedures outlined in 

Appendix 3 and SOP 4.   

 

Product Composite Length Availability 
(# of days) 

Source 

Calibrated Radiance daily 1 LAADS 

Vegetation Index 16-day 5-7 LP DAAC 

Snow Cover Extent 8-day 3-4 NSIDC DAAC 

Snow Cover Extent daily 2-3 NSIDC DAAC 

 
Table 8.   Approximate data availability schedule for each MODIS product. 

 

Hardware Capability 

 

The hardware requirements for processing, storage, and analysis of MODIS satellite 

imagery include a personal computer with a minimum of 2.0 GHZ processor and 1.0 GB 

or greater of memory.  These are minimum requirements; to achieve maximum 

performance in processing and manipulation of imagery, more powerful processors and 

memory are necessary. A minimum hard drive capacity of 200 GB is recommended for 

MODIS processing and storage.  

 

Software 

 

The software requirements for utilizing MODIS data sets can be categorized into two 

groups.  Software tools necessary for the acquisition and processing of raw MODIS tiles 
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and swaths, and software packages that allow the processed imagery to be viewed and 

analyzed with other spatial data.  

 

The software tools for acquisition and processing of MODIS tiles and swaths include the 

following: 

 MODIS Reprojection Tool (MRT) 

 MODIS SWATH Reprojection Tool (MRT-Swath) 

 Land Data Operational Product Evaluation (LDOPE) 

 

All of these are freeware tools that can be downloaded from the LPDAAC website 

(http://edcdaac.usgs.gov/datatools.asp). 

 

The image processing and GIS software that is used for display and analysis of processed 

imagery will be left to the discretion of the NPS.  However, we recommend RSI’s ENVI 

image processing software and ESRI’s ArcGIS.  Adobe Photoshop is also an invaluable 

tool for rapid image viewing and feature enhancement. 

 

Software installation instructions (MRT, MRT-Swath, and LDOPE) are found in SOP 1. 

 

 

VIII. Procedures for Revising Protocol 

 

The steps for changing the protocol (either the protocol narrative or the SOPs) are 

outlined in SOP 6.  Each SOP contains a revision history log that should be filled out 

when a SOP is revised.  The new version of the SOP and/or protocol narrative should 

then be archived in the SWAN protocol library under the appropriate folder. 

 

 

http://edcdaac.usgs.gov/datatools.asp
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This Standard Operating Procedure outlines the installation instructions for software 

necessary to acquire, process, and reformat the standard MODIS image products set forth 

in this protocol.  The software tools for processing raw MODIS tiles include:  

 

 MODIS Reprojection Tool (MRT) 

 MODIS Swath Reprojection Tool (MRT-Swath) 

 MODIS Land Data Operational Product Evaluation (LDOPE) Tools 
 

This SOP also includes instructions for IDL Metrics setup in order to utilize the tools for 

deriving seasonal metrics from the NDVI time series. Separate procedures for installing 

each of these tools are outlined below. 

 

The MODIS tools are freeware downloadable from the Land Processes Distributed 

Active Archive Center (LP DAAC) website:  (http://edcdaac.usgs.gov/datatools.asp).  

The IDL Metrics tools have been provided to the SWAN for use in this protocol. 

 

 

1.1. MODIS Reprojection Tool (MRT) 

 

The MRT software tool enables users to read data files in HDF-EOS format (MODIS 

Level-2G, Level-3, and Level-4 land data products), specify a geographic subset or 

specific science data sets as input to processing, perform geographic transformation to a 

different coordinate system/cartographic projection, write the output to file formats other 

than HDF-EOS, and are executable on Unix (Sun, SGI), Windows (9x, 2000, NT, XP), 

and Linux operating systems. 

 

This SOP is intended for use on the Windows operating system. 

http://edcdaac.usgs.gov/datatools.asp
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MRT Installation Procedures: 

 

 

1.   Register for access to the MODIS download page at the LP DAAC.  From the 

 MRT distribution page (http://edcdaac.usgs.gov/landdaac/tools/modis/index.asp), 

 select registration and receive a username and password that allows for 

 downloading of binaries, source code, and documentation (Fig. 1.1).  A username 

 and password will be emailed to the address that you provide. 

 

 
 
Figure 1.1.  Registration procedure for MODIS Reprojection Tool. 

  

 

  

2.   Log on to “Registered User Services” using your login information for access to 

  Downloads (Fig. 1.2). 

http://edcdaac.usgs.gov/landdaac/tools/modis/index.asp
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Figure 1.2.  Login procedure for downloading MRT. 

 

 

3.   From the Registered User Services page, select Download to access release notes  

and code for the appropriate platform (Fig. 1.3).  The standardized procedures for 

this protocol are intended for use on the Windows platform. 

 

 
 
Figure 1.3.  Initiating download procedure for MRT files. 

 

 

4.   Create a MRT directory on the C drive (i.e. C:\MRT) of your local computer.  Use 

‘right click’, ‘save target as’ to individually copy each Windows platform file 

from the download page to the C:\MRT directory (Fig. 1.4). 
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Figure 1.4.  Download procedure for MRT. 

 

 

 

5.   Open a command prompt window and navigate to the C:\MRT directory where 

the Windows files were saved.  Type install.  You will be given information 

necessary for continuing installation of the MRT and for obtaining necessary Java 

software if it is not already installed on your system.  Java is used for the 

graphical user interface (GUI) version of the MRT.  Issues related to Java 

software are discussed in procedure # 8.  At this prompt, type y to continue with 

the installation . 

 
6.    You will then be prompted to enter an MRT directory path.  Since you’ve already 

created the C:\MRT directory, press enter to install to a MODIS sub-directory at 

this location.  A second prompt will state that the MODIS sub-directory doesn’t 

exist and ask if you want to create it.  Type y to continue. 

 
7.   The installation will proceed to create a MODIS directory in the current location 

and extract a number of files/folders to the new directory.  You will then be 

prompted to identify what version of Windows you are running.  Simply type the 

number associated with your operating system and press enter. 

 
8.   You will be prompted to enter the path to the Java bin directory on your machine. 

Most PCs already have Java installed in C:\Program Files\Java\…, since the MRT 

does not process pathnames with spaces in them it will error if this path is given.  

You will need to make a copy of the Java directory and place directly under the C 

drive (i.e. C:\Java\...etc.). The next step in installation is to type the full path to 

the Java bin directory and press enter.  The install program will test the Java 

path and verify that it is an adequate version. If the version of Java does not meet 

the minimum requirements, a web location for downloading a newer version is 
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provided (Fig. 1.5).  In the event that your system does not contain a Java bin 

directory, you can access the latest version of Java at the following location: 

http://java.sun.com/downloads/.  Select the most recent version from the Java 

Platform Standard Edition dropdown list. 

 

 
 
Figure 1.5.  Enter the pathname of the Java bin directory. 

 

9.   Once the installation is complete, you should see the successful installation 

Screen (Fig. 1.6).  You can test the installation by navigating to 

C:\MRT\Modis\bin and double click on the ModisTool.bat file.  If installed 

properly, this should launch the GUI interface for the MRT. 

 

 
 
Figure 1.6.  Message confirming successful installation of MRT. 

http://java.sun.com/downloads/
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10.   Installation problems with the MRT are almost exclusively related to directory 

paths.  If you experience problems with the installation, the first place to 

troubleshoot would be the ModisTool batch file referred to in procedure 9.  Using 

a text editor such as Notepad, open the batch file and confirm that the directory 

paths are accurate with regard to where files are located on your local computer 

(Fig. 1.7).  Correct paths as necessary, select File > Save, and test.  Note:  The 

MRT will not work with any spaces in the path or file names. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 1.7.  Text editor description of filenames to confirm proper naming conventions. 

 

11.   If you are unable to troubleshoot the problem, please contact the LP DAAC User 

      Services at the following address: 

 
LP DAAC User Services 
U.S. Geological Survey (USGS) 

Center for Earth Resources Observation and Science (EROS) 

47194 252
nd

 Street 

Sioux Falls, SD 57198-0001 

Phone :     605-594-6116 

Toll Free: 866-573-3222 

      866-LPE-DAAC 

Fax:          605-594-6963 

Email:      LPDAAC@eos.nasa.gov 

Web:      http://LPDAAC.usgs.gov 

Hours:      8:00 a.m. – 4:00 p.m. (Central Time Zone) 
 

 

 

 

mailto:LPDAAC@eos.nasa.gov
http://lpdaac.usgs.gov/
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1.2. MODIS Swath Reprojection Tool (MRT-Swath) 
 

The MRT-Swath were developed by the Land Processes Distributed Active Archive 

Center (LP DAAC) for re-projecting MODIS Level 1-B and Level 2 swath data to 

gridded products.  This tool will be used for processing of the MODIS Calibrated 

Radiance data (MOD02) and associated MOD03 geolocation files. 

 

The installation procedures for the MRT-Swath tool are identical to those for the standard 

MRT outlined in section 1.1 of this SOP. 

 

1.  Use the same username/password that was emailed to you on registration for the 

 MRT to access the “registered user services” link on the MRT Swath distribution 

 web page, http://edcdaac.usgs.gov/landdaac/tools/mrtswath/index.asp (Fig. 

1.8).    
 

 

 

 
 
Figure 1.8.  MRT-Swath distribution page. 

 

 

 

http://edcdaac.usgs.gov/landdaac/tools/mrtswath/index.asp
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2. From the “registered user services” page select “download” to access the 

 Windows platform files as outlined in step 3 of the MRT installation. 

 

3. Create a MRTswath directory on the C drive (i.e. C:\MRTswath) of your local 

 computer.  As with the MRT installation, use‘right click’, ‘save target as’ to 

 individually copy each Windows platform file from the download page to the 

 C:\MRTswath directory. 

 

4. Follow steps 5 – 10 of the MRT installation substituting the “C:\MRTswath” 

 directory path in place of “C:\MRT” in that procedure.  The MRT-Swath also uses 

 Java for its graphical user interface, so the same considerations with regard to the 

 Java bin directory apply here.  If you’ve already installed the MRT, the directory 

 structure of access to the Java bin directory has already been established. 

 

 

 

 

1.3. MODIS Land Data Operational Product Evaluation (LDOPE) 

 
The LDOPE software tools were developed to assist with the analysis and quality 

assessment of the MODIS Land (MODLAND) products. The tools have been developed 

with feedback from the MODLAND science team and incorporate the scientific 

knowledge, experience and insights gained during the substantial MODLAND product 

development period. These software tools are invoked as stand-alone executables from a 

command-line interface. The software is supported on Irix, Solaris, Linux, and Windows 

operating systems. 

 

 

LDOPE Installation Procedures: 

 

1.   Since the LDOPE tools are also distributed through the LP DAAC, the same 

username/password established to download the MRT and MRT-Swath tools can 

be used for the LDOPE downloads (see MRT procedures 1 & 2 in SOP 1.1). 

 

2.   Log on to the MODIS LDOPE “registered user services”webpage, 

http://edcdaac.usgs.gov/landdaac/tools/ldope/dist/index.asp, using your login. 

 

3.   From the Registered User Services page, select download to access installation 

guide and runtime executables (Fig. 1.9).  For the Windows operating system, 

download Win_bin.zip from the runtime list and save it directly to the C drive. 

 

 

 

 

 

 

http://edcdaac.usgs.gov/landdaac/tools/ldope/dist/index.asp
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Figure 1.9.  Initiating download for LDOPE software. 

 

 

4.   On the C drive, right click > LDOPE_Win_bin.zip file, and choose extract to 

folder (Fig. 1.10). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 1.10.  Download procedure for LDOPE software. 
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5.    The directory LDOPE_Win_bin includes two subdirectories: bin and 

ANCILLARY. The ‘bin’ directory contains the LDOPE executable files and the 

‘ANCILLARY’ directory contains the projection parameter files containing the 

projection parameters for all land tiles in Sinusoidal and Integerized Sinusoidal 

projections . 

 
 
6.   The next step is to set an environment variable (ANCPATH) that points to the 

ANCILLARY directory.  Begin by clicking the Windows “start” > “settings” >  

“control panel”. Double click on the “system” icon. (Fig. 1.11) 

 

  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 1.11.  Accessing the system properties dialog box. 

 

 

7.   From the system properties menu select the “advanced” tab and click on 

“environmental variables” to open the environment variables listing (Fig. 1.12). 
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Figure 1.12.  Accessing the Environmental Variables listing. 

 

 

8.         In the top panel labeled “user variables …”, select new and put the following in  

the “new user variable” window: Variable Name = ANCPATH and Variable 

Value = C:/LDOPE_Win_bin/ANCILLARY.  Click Ok (Fig. 1.13). 
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Figure 1.13.  Assigning the ANCILLARY path to the ANCPATH variable. 

 

9.         An optional step, is to add the binary (‘bin’) directory path to the $PATH variable  

to allow the LDOPE executables to be run from any directory on the local 

machine. Access the environmental variables window (procedure 7). Select the 

PATH variable from the list and click the edit button. Add the binary directory 

path (c:\LDOPE_Win_bin\bin) preceeded by a semicolon (;) to the list of 

variable values. Click ok to apply changes (Fig. 1.14).  

 

 

 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 
Figure 1.14.  Assigning $PATH directory to allow the LDOPE executables to be run from any 

directory. 

 

 

 

 

 

You have completed installation of software tools for processing raw MODIS HDF-EOS 

files.



12/15/06 Satellite –Derived Measures of Landscape Processes 

SOP 4 - Version 1.00 

39 

1.4. IDL Metrics Setup 
 

The IDL tools are used for deriving seasonal metrics (i.e. start of season, end of season, etc.) 

from the NDVI time series data.  The program files for executing the tools must reside in a 

specific directory structure that must be referenced within the IDL preferences.  

 

IDL Metrics Setup Procedures: 

 

1. The first consideration is that the METRICS/idl/bin directory must reside  somewhere on 

the local machine (Fig. 1.15).  This directory and sub-directories  have been provided to the 

SWAN. 

 

 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 1.15.  Example of the location of the METRICS/idl/bin directory.  

 

 

2. Access IDL to add the directory path to the IDL preferences.  Click Start > 

 Programs > RSI ENVI > IDL.  
 

 

3. From the IDL window, select File > Preferences.  Within the preferences dialog  box 

select the path tab and use the insert button to navigate to the  METRICS/idl/bin directory 

and select ok. This will add the directory path to the  IDL preferences (Fig. 1.16).   
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Figure 1.16.  Setting the METRICS/idl/bin directory path in the IDL preferences. 

 

4. The next step is to set the working directory where your data reside and where the 

 output of the “imetricsoncube” program will be written.  To do this select the  startup 

tab from the IDL preferences.  If you’ve closed the preferences dialog, use  File > 

Preferences to reopen.  From the startup tab, use the browse button to  navigate to the 

working directory and select ok (Fig. 1.17).   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 1.17.  Setting the Working Directory. 

 

This completes the process for the IDL Metrics setup.  Procedures for executing these program 

commands are included in SOP 2. 
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This Standard Operating Procedure outlines the procedures for acquisition and processing of the 

standard MODIS Vegetation Index (MOD13Q1) product.  This product is available from the 

Land Processes Distributed Active Archive Center (LP DAAC) Data Pool. 

 

One of the intents of this protocol is to make the processing and analysis of these data more 

automated and therefore more standardized and user-friendly.  The procedures outlined below 

represent those steps necessary to execute a set of scripts that have been provided to the SWAN 

in an effort to meet this intent.   

 

The processing of MODIS NDVI products should be performed according to the processing 

schedule outlined in Table 2.1. 

 

Action SOP Frequency 

Data acquisition 2.1 Monthly 

NDVI processing 2.2 Yearly 

NDVI data exploration 2.3 Yearly 

NDVI data smoothing 2.4 Yearly 

Phenology Metrics 2.5 Yearly 

Reporting 2.6 Yearly 

 
Table 2.1  MODIS NDVI processing schedule. 

 

The output from this set of SOPs will be georeferenced NDVI data at a 16-day compositing 

schedule for the SWAN region.  From the NDVI data, phenological metrics (e.g., time of start of 

growing season, duration of season, etc) are computed and then statistically summarized for 

ecoregions within SWAN. 
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The software and scripts that are required to run this set of SOPs are listed below in Table 2.2. 

 

Software Process 

File transfer protocol (ftp) File transfer 

ListHDF_v2 List HDF file names 

MRT Process hdf files 

ENVI Image processing 

Smooth Smooth NDVI data 

IDL Calculate phenology metrics 

IDLmetrics scripts Calculate phenology metrics 

VI Processing scripts Process VI files 

Excel (or other spreadsheet) Reporting 

 
Table 2.2.  Required software for processing NDVI data. 

 

 

MODIS 250m 16-day Vegetation Index (MOD13Q1) 

 

Any use of the general “VI” term is in reference to the standard NASA-EOS MODIS Vegetation 

Index product which contains both a normalized difference vegetation index (NDVI) and 

an enhanced vegetation index (EVI) product.  In this protocol, only the NDVI product is 

utilized.   

 

2.1  Data Acquisition Procedures 

Required software: none 

 

The MOD13Q1 products are routinely placed into the LP DAAC Data Pool as soon as they are 

produced.  The data policy at the time of this writing is to keep one year (the most recent year) of 

the VI product online at the Data Pool at any one time.   

 

Each month, the data technician should navigate via a web browser to the Data Pool and 

download all new MOD13Q1 data to the local, operational computer.  To access the data: 

 

 Open an Internet browser of your choice. 

 

 Navigate to the website for the Data Pool: 

 

  http://lpdaac/datapool/datapool.asp 

 

 After reaching the Data Pool, click FTP MODIS (Fig. 2.1) 
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Figure 2.1 Navigating the LP DAAC Data Pool 

 

 Double-click the file folder labeled MOD13Q1.004 (or current version of the 

MODIS collection; see SOP 6 regarding revisions to the Protocol for new MODIS 

collections).   

 

You will see a set of file folders that are labeled with a date corresponding to the 

first date of a composite period.  For example, a file folder labeled “2006.09.14” 

will contain MOD13Q1 16-day composite data beginning on 14 September, 2006.   

 

 Double click the file folder name that corresponds to the data you wish to 

download.  You will see a listing of many file names.   

 

 For easier navigation, change the view of your Internet browser by clicking on 

the View tab at the top of the browser and selecting Details. 

 

The MOD13Q1 files are listed in tile order.  The tiles are sorted first by the 

horizontal tile number and next by vertical tile number.  The first listed tile (using 

the 2006.09.14 folder) is: 
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MOD13Q1.A2006257.h00v08.2006280030442.hdf 

 

The above file name is parsed according to the following: 

 MOD13Q1 – product name 

A2006257 – Acquisition date; year 2006, day 257 (beginning of  

composite period) 

   h00v08 – horizontal and vertical tile numbers 

   2006280030442 – processing time; year 2006, day 280, hour 03,  

minute 04, second 42 

 

Note:  Many MODIS files are named according to their Julian Date.  Julian day 

is simply the sequential day number, starting from Jan 1 and running through Dec 

31.  In the example above, day 2006257 is Sept 14, 2006.  Julian dates will 

change during leap years. 

 

 Scroll downward until identifying the 6 tiles that comprise the SWAN and 

highlight each of the files by left mouse-clicking on the first file, then 

depressing the control key and clicking the left mouse button on the subsequent 

file names (Fig. 2.4).  It is only necessary to select the *.hdf files, not the 

*.hdf.xml.  The files that should be selected are:   

 

h09v02, h09v03, h10v02, h10v03, h11v02, h11v03 
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Figure 2.2.  Selection of files in data pool. 

 

 Open the destination file folder (e.g. D:\SWAN\MODIS_VI_16day\2006).  

 

 Drag and drop the selected files from the Data Pool into the file folder. 

 

  Notes:   

Depending on the connection speed of the local network, the download may take 

some time.  If a large number of 16-day periods are being acquired at one time, it 

is recommended that this acquisition step be run overnight. 

 

Another caveat is that the LP DAAC has standard maintenance periods every 

Wednesday from 7a.m. to 11a.m. Central time and other unforeseen downtimes.  

SWAN personnel should avoid trying to acquire data during the scheduled 

downtime and should be aware that problems with the MODextract process may 

be due to server issues at the LP DAAC.  These are listed on the Earth Observing 

System (EOS) Data Gateway welcome page 

(http://edcimswww.cr.usgs.gov/pub/imswelcome/).  The user may need to scroll 

down the page to access the LPDAAC. 

 

 

 

 

Earth Observing System Data Gateway (EDG) for Data Acquisition 

 

In the event that any of these data are no longer available via the respective data pools, an 

alternative method for data acquisition does exist.  The EOS Data Gateway provides a method 

for searching and ordering any of the MODIS data sets from all DAAC locations. 

Detailed procedures on how to use the EDG are provided in Appendix 3 “Grid data for Surface 

Reflectance processing” 
 

SOP 2.2  NDVI  Processing 

Required Software:  MRT, VI processing scripts LDOPE? 

 

After a year’s collection of MOD13Q1 HDF files (23 files that correspond to 23 time periods – 

the number of 16- day periods in a year) have been transferred to the local SWAN machine, the 

next step is to execute a program called List_HDF_v2.exe.  This script is provided to SWAN on 

the “Big Disk” remote hard drive of images and software, and can be found in the 

D:\SWAN\MODIS_Software directory.  List_HDF_v2 creates a text file of the file names that is 

used in the next SOP, where all the HDF files are processed. 

 

 Double click on the List_HDF_v2 executable to open a small dialog box.  Using 

the dropdown file structure, point to the directory where the HDF files reside and 

will be processed and click ok. 

 

 Navigate to the directory (e.g. D:\SWAN\MODIS_VI_16day\2005) and assure 

that a set of new files named yyyyddd.txt have been written.  Each of these files 

http://edcimswww.cr.usgs.gov/pub/imswelcome/
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contains the list of hdf file names that correspond to each of the 16-day composite 

periods 

 

Execute the batch file SWAN_vi_script.bat found in the annual directory where data are being 

processed (D:\SWAN\MODIS_NDVI_250m\2005 in this example).  The batch file will process 

only those files for which text files (created above) and original HDF files exist.  Note that the 

ASCII text files from which that *.bat files were created are also included in the directory for any 

unexpected editing that may be required (in case of MODIS version changes, path name changes, 

etc.). 

 

 Execute the script by double-clicking on the filename. 

 

The execution of this batch file will launch an MS-DOS window that shows the progress of the 

processing.  The batch file uses command line MRT processes and LDOPE quality evaluation 

tools to process the vegetation index data.  

 

1)  The first step of this process creates a mosaic of the NVDI band (band 1).   

 

2)  The second step of the process creates a mask of poor quality data by accessing 

quality assurance information in the NDVI_Quality band (band 3).  Poor quality data 

include pixels with high aerosol content, cloud contamination, or snow and ice cover.   

 

3)  The third step applies the quality mask to the NDVI mosaic  

 

4)  The fourth step executes the resample, subset, reproject, and reformat parameters to 

produce a single band NDVI image for analysis.   

 

5)  The final step of the process deletes temporary files that were created during the 

processing. 

 

The output from this procedure is a set of 23 NDVI files (one for each 16-day composite period) 

in Geotiff format (with *.tif file extension) covering the SWAN region, in an Alaska Albers map 

projection. 

 

 Navigate from the My Computer icon to the file folder where the data reside (in 

this example, it is D:\SWAN\MODIS_NDVI_250m\2005).  Assure that the output 

files are present.  Their filenames will be, for example: 

 

NDVI_2005_001.250m_16_days_NDVI.tif (for composite period beginning with 

day 1 of the year) 

 

 

 

SOP 2-3.  Interpretation of Normalized Difference Vegetation Index (NDVI) data 

 

This section describes one of several possible approaches for exploratory analysis and 

interpretation.  The NDVI data interpretations require layer stacking of multiple NDVI images 

and comparing the images from one year (or multiple years) to another (e.g., an index year of 
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historical extreme) or to the recent historical average.  The following procedures assist the user 

to interpret the NDVI data sets: 

 

1) Layer stacking 

2) Link windows and create corresponding Z-profiles 

3) Data smoothing 

4) Plot NDVI time-series in Excel 

5) Compare data to “average” conditions 

-Calculate statistics 

-Create difference image  

 

 

 

 

SOP 2.3.1  Layer stacking 

Required Software:  ENVI 

 

 Initiate ENVI by double-clicking on the ENVI icon on your desktop.  In the main 

ENVI window, open the NDVI data files using the following procedure. 

 

 File > Open Image File 

 

Assure that you navigate to the proper file folder where the data that were 

processed in SOP 2.2 reside.  The files have the filename structure: 

 

NDVI_2005_001.250m_16_days_NDVI.tif 

 

 Select (and open) all of the NDVI *.tif files that were output from the MODIS 

scripts for one year of observations.  This will result in a total of 23 selected 

images for a single year.  Scroll through the “Available Bands List” to assure that 

all of the images are present. 

 

 View one (or more) of the images by highlighting the image name (for example, 

NDVI_2005_321.250m_16_days_NDVI.tif, by clicking the Band 1 listing under 

the filename, then clicking the Load Band button at the bottom of the window 

(Fig. 2.3). 
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Figure 2.3  Selection of image for file display 

 

 

Three display windows will pop up, displaying the image at three different levels of 

detail; the “scroll” window displaying the entire image at reduced resolution, the “image” 

window (largest of the display windows) displaying the image at 1/1 pixel resolution, and 

the “zoom” window at a default (but adjustable) zoom of 4x.  To adjust the zoom power, 

you may click on the -/+ buttons at the bottom of the popup window. 

 

In the next procedure, you will stack all of the images (layers) into one multi-band image 

in order to begin analysis of the data as a one-year data set. 

 

 From the Main ENVI window, select Basic Tools > Layer Stacking 

 

 Click the Import File button. 

 

o select all of the *.tif files as Input Files from the Available Files list.  You 

may select all of the files at the same time, by using the control or shift 

key on your computer while mouse-clicking.  After all the files have been 

highlighted, Click OK. 
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In order to analyze the data in the proper temporal sequence, assure that the files are in 

the correct chronological order (image one corresponds to the Jan 1 observation, etc.).  

For example, Fig. 2.4 lists the data in reverse chronological order.   

 

 

 
 

Figure 2.4.  Listing of Input files for Layer Stacking procedure. 

 

 

 Click the Reorder Files button – Note that the center mouse button reorders from 

bottom to top.  Assure that the filenames are in the proper order: 

NDVI_2005_001.250m_16_days_NDVI.tif 

NDVI_2005_017.250m_16_days_NDVI.tif 

NDVI_2005_033.250m_16_days_NDVI.tif 

NDVI_2005_049.250m_16_days_NDVI.tif 

   . 

   . 

   . 

 

 Enter Output Filename > SWAN-NDVI-2005.   

Note:  Assure that you have navigated to the proper destination file folder before 

clicking OK to initiate the process. 

 

The newly created Layer Stack will now appear in the Available Bands List. 
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 Display the new file by highlighting one of the Layers in the SWAN-NDVI-2005 

file and clicking the Load Band button in the Available Bands List 

 

 To display the temporal sequence (profile) of the NDVI data, right click in one of 

the Display windows and select Z profile (spectrum).   

 

This displays a scaled NDVI value on the y-axis and band number (corresponding to time of 

year) on the x-axis (Fig. 2.5). 

 

 

 

 
 
Figure 2.5.  Temporal profile of a pixel. 

 

You can observe instances of snow and cloud contamination (-4000 values) that need to be 

addressed before phenology metrics may be calculated. 

 

 

SOP 2.3.2  Link Windows and create corresponding Z-profiles 

Required Software:  ENVI 

 

The following methodology may be used to compare any set of time-series NDVI images.  It is 

assumed that the layer stacking for individual years of VI has already been performed and are 

available for processing.   

 

 Clear all images from the Available Bands List by clicking File in the Available 

Bands List window and selecting Close All Files.  You will receive a warning 

that this will close all files.  This is, indeed, what you wish to do, so select OK. 

 

To compare two (or more) years of data, first open the image data and make sure they appear in 

the Available Bands List.   
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 In the Available Bands List window, click File and select Open Image File.  

Navigate first to the file folder containing a stacked data set, as prepared in the 

previous SOP.  Select the stacked year (e.g., SWAN-NDVI-2005). 

 

 Repeat the previous step and select a different year of stacked NDVI data (e.g., 

2004). 

 

Display the same band (say, Band 3) for each year in its own display window.   

 

 First highlight one of the bands from 2004 (e.g. the 3
rd

 listed layer), then click 

Load Band at the bottom of the Available Bands List window as in Fig. 2.3. 

 

 Scroll down in the Available Bands List until you reach the 2005 data, and 

highlight the same band as you did for the 2004 data (e.g. the 3
rd

 layer).  At the 

bottom of the Available Bands List window, click the Display # 1 button – select 

New Display.  A blank display window will appear.  Now click Load Band and 

the highlighted image band will be displayed. 

 

In the next sequence, link the two display windows and display the temporal sequence for the 

same area (pixel) for the two separate years. 

 

 Right click in one of the display windows and click Link Displays.  A popup 

window will appear prompting for which displays should be linked.  Leave the 

default values as are and click OK.   

 

 To display the Z-profile (temporal sequence in this example), right click on the 

display window and select Z-profile (Spectrum).  Repeat for other display 

window(s).   This creates a popup window with a temporal profile of the NDVI 

for each specified year.   

 

You may now navigate through either of the images and left-click any place on the image and 

the Z-profiles for each year of data will update.  To compare the individual years, it is important 

that the graphic scales be the same.  The ENVI Z-profile function scales the y-axis depending on 

the data ranges.   

 

 The y-axis scaling may be fixed by using the Z-profile window menu Edit > Plot 

parameters.  Select Y-Axis and use a range of 0 to 9000 and click OK.  Repeat 

the scaling for both Z-profile windows.   

 

The resulting graphs may be compared side-by-side to identify differences in vegetation activity 

between years.  For example, Fig. 2.6 illustrates NDVI differences between 2001 (left) and 2004 

(right) for a single pixel.  While the early season characteristics between the two years are 

similar, the profile for 2004 shows an extended autumn (lasting one or two observations longer 

than 2001).   
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Figure 2.6.  NDVI profiles for 2001 (left) and 2004 (right) for a pixel in SWAN 

 

 

SOP 2.3.3  Data Smoothing 

 

Many NDVI images exhibit areas with unsatisfactory values (masked out during the QA 

procedures) that were identified during SOP 2.2.  A smoothing procedure can be performed on 

the NDVI imagery that eliminates the masked values by substituting temporally interpolated 

values.  This results in a clean image that is appropriate for interannual analysis (Fig. 2.7). 

 

 

 

 

 
 
Figure 2.7.  Before (left) and after (right) smoothing images of NDVI. 
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The smoothing operation permits a more realistic depiction of the vegetation conditions 

throughout the year (Fig. 2.8). 

 

 

 
 
Figure 2.8.  Results of smoothing operation on annual time-series. 

 

 

To perform the smoothing operation, you first convert the data to byte range, then combine 

multiple years for assuring that the temporal smoother has data both before and after the dates of 

analysis for its operation (it operates using a temporally moving window), then execute the 

smoothing operation. 

 

 

SOP 2.3.3.1  Convert the data to byte data range 

Required Software:  ENVI 

 

The smoothing procedure operates on a stacked data set.  The first step in this process is to 

convert the previously stacked data to byte range - this reduces the data volume, while retaining 

the temporal characteristics of the data that are required for the time-series phenology analysis. 

 

To convert to byte: 

 

 ENVI > Basic Tools > Band Math   

o Within the Band Math window, Enter an expression:  

 

byte((b1/100)+100) 

 

This expression has been supplied to the SWAN in a restorable file.  You may 

restore this expression by clicking the Restore button and navigating to where 

the file is stored:  (D:\SWAN\ENVI_Expressions\BandMath-byte).  Assure 

that the expression is highlighted and click OK. 
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 A new window will open Variables to Bands Pairings > Map Variable to Input 

File >  

o Select the stacked image created earlier: SWAN-NDVI-2005 

o Enter Output Filename: Navigate to proper file folder and enter SWAN-

NDVI-2005-byte  (Fig. 2.9) 

 

 
 
Figure 2.9.  Band Math expression to convert to byte 

 

 

This step converts the VI data from a scaling of 1/10,000 to the 0-200 data range. 

In this new scaling, the data may range from 0-200, where a NDVI value of -1 corresponds to 0, 

an NDVI of 0 = 100, and an NDVI of 1 = 200.   

 

The data are now ready to be prepared for temporal smoothing to eliminate the snow, cloud, and 

aerosol contamination. 

 

Note:  If there is ever a need to convert to “true” NDVI values (such as reporting values 

for a publication), use the equation:   NDVI = (Scaled NDVI -100) / 100 
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SOP 2.3.3.2  Prepare multiple-year data stack for smoothing 

Required Software:  ENVI 

 

Since the smoothing process utilizes a temporal moving window (Swets et al, 1999) it requires 

that data be present both before and after the data that are to be smoothed.  Therefore, the next 

step is to “pad” the data that are to be smoothed (2005) with one year of data before (2004) and 

one year of data after.  In many cases, such as this example, we repeat the final year of the series 

(in this example, 2005, again) when the collection for the following year (2006) has not yet been 

completed.  Assuming that no data sets are open and in the Available Bands List, begin ENVI 

and: 

 

 Open Image File > Open the 2004 stacked, byte data. 

 

 Open Image File > Open the 2005 stacked, byte data. 

 

 Basic Tools > Layer Stack  

  Import File…import stacked 2004 data 

  Import File…import stacked 2005 data 

  Import File…import stacked 2005 data again 

 

 Assure that the files are in the proper order: 2004, then 2005, then 2005 again.  If not, 

initiate the Reorder Files function.  Choose an output filename (SWAN-NDVI-

040505-byte), press OK.  This will result in a 69-band file that is ready to be 

smoothed. 

 

 

SOP 2.3.3.3  Run Smoother 

Required Software:  Smooth, ENVI 

 

The data are now ready to be temporally smoothed using techniques described by Swets and 

colleagues (1999). 

 

 Begin a command prompt window (Start > Programs > Accessories > Command 

Prompt) and change directories to the location of the smoother program, first by 

switching to the appropriate drive (e.g. > d: ), then changing directories to the 

appropriate path  (d:\>  cd SWAN\Smoother). 

 

This file folder contains the correct parameter file for executing the smoother for each year (e.g., 

smoothparams2005.txt). 

 

 Initiate the smoothing algorithm from the command prompt: 

d:\swan\smoother> smooth smoothparams2005.txt 

 

Note:  the input and output paths in the smoothparams200*.txt file may need to be changed 

(using a text editor) to correspond to the source and destination file folder locations. 
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The smoother will then begin operation and will update the operator by displaying each line that 

is being processed.  The estimated operating time for this operation is 20-30 minutes, depending 

on computer speed, other processes that are running, etc.   

 

The results may then be displayed in ENVI from either the main ENVI window or the Available 

Bands List by the following procedure. 

 

 Open Image File > navigate to where the new smoothed image resides and select it > 

SWAN-NDVI-040505_sm 

 

Since the image was created outside of ENVI, it does not yet have valid header information (file 

description, projection information, etc.) so a popup window will appear and request information 

about the file.   

 

 Select Input Header Info From > Other File and select the previous byte image 

(SWAN-NDVI-040505-byte).   

 

Note: this file (SWAN-NDVI-040505-byte) must be in the Available Bands List – if not, open the 

image using procedures described earlier.   

 

This will assign the proper header information to the file.   

 

 Display the file using procedures described earlier 

 

 Right click within one of the image windows and select Z-profile (Spectrum) to 

view the new, smoothed temporal profile of the NDVI imagery.  Note that the new 

graph displays 3 years of data, due to the stacking of multiple years (Fig. 2.10). 
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Figure 2.10.  Three years of smoothed data. 

 

 

SOP 2.3.3.4 Subset image into one, smoothed year of data 

Required Software: ENVI 

 

Now that the year of concern (2005 in the example) has been smoothed, it needs to be taken from 

the 3 year stack, so it can stand alone and be used for other applications.  From the ENVI Main 

Menu, select: 

 

 Basic Tools > Resize Data (Spatial/Spectral).  This will popup a window prompting 

the user to Select Input File.  Select the file that has been smoothed and with the 

header information added (SWAN-NDVI-040505_sm, in this example). 

 

The window will then activate fields for Spatial Subset and for Spectral Subset. 

 

 Click Spectral Subset.  This will popup a new window called File Spectral Subset that 

lists all the individual date images (bands) that comprise the stacked image in 

chronological order.  Scroll down the window until you reach the first band of the 

year that you are trying to isolate (Fig. 2.11).  Highlight this band and all other bands 

(using the shift or control key) for the year of data that you are subsetting.  Click OK.   

 

This will return you to the Resize Data Parameters window.  Do not change any other file 

parameters.   

 

 Enter Output Filename (e.g., SWAN_NDVI_2005_sm).  Click OK. 

 

 
 
Figure 2.11.  Listing of bands in spectral subsetting process. 
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SOP 2.3.4  Plot NDVI time-series in Excel or other spreadsheet 

Required Software: ENVI and Excel (or other spreadsheet) 

 

By comparing the annual time series between two different years, patterns of vegetation activity 

may be analyzed.  Besides examining the data using the ENVI Z-profile function, it is also 

possible to transfer the data points to Excel to perform spreadsheet functions on the data (for data 

manipulation, display, etc.). 

 

To transfer the data to Excel, first display the one-year image created in the previous SOP. 

 

 Right click in the image window and select Z-profile (Spectrum). 

 

 use the Z-profile window menu and select File  Save Plot As  ASCII.  A popup 

window will appear.  Highlight the Select Plots to Output (Fig. 2.12) and enter an 

Output Filename.  Click OK 

 

 

 

 
 
Figure 2.12.  Output Plot to ASCII window. 

 

 

This will save the plot values to an ASCII text file, which can then be easily imported into Excel 

or another spreadsheet or database.  In this manner, several annual plots may be saved and 

plotted on the same graph so that interannual differences in vegetation activity may be viewed 

simultaneously for any pixel (Fig. 2.13).  This kind of chart may be used to interpret the 

vegetation dynamics of a pixel for each year.  In this example, it is clear that 2001 had the 

shortest growing season, while 2003 and 2004 had earlier springs. 
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Figure 2.13.  Annual vegetation index temporal curves from 2000-2004. 

 

 

 

SOP 2.3.5  Compare data to “average” conditions 

Required Software: ENVI 

 

It is often useful to compare a current observation with the average conditions.  This SOP 

describes calculating average conditions as defined by the conditions during the period of data 

collection (since 2000 in the case of MODIS) and then a technique for visualizing a comparison 

of current conditions (or conditions from any single year of observation) to the average. 

 

 

SOP 2.3.5.1 Calculate Statistics 

Required Software: ENVI 

 

ENVI permits the ready calculation of mean values by the following procedure.  In this 

example, a mean NDVI multi-band image will be created.   

 

 First, open all six of the smoothed NDVI images, one for each year 2000 – 2005, 

using procedures described earlier.   These are found in the file folders, 

D:\SWAN\MODIS_VI_16day\yyyy, where yyyy is the year of observation.  

 

 From the ENVI main menu click Basic Tools  Band Math.  A Band Math 

popup window will appear. 

 

 Within the Band Math popup window, Enter an expression.  For calculating the 

mean for six layer-stacked images, the expression may be: byte ((B1 + B2 + B3 + 

B4 + B5 + B6) / 6), where B1 through B6 are the stacked images for Year 1 
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through Year 6.  When the expression is satisfactory, click OK.  A Variables to 

Bands Pairings popup window will appear. 

 

Within the Variables to Bands Pairings window, the user is required to assign the 

variables to data that are in the Available Bands list.   

 

 Highlight the first Variable (B1 – [undefined]), click the Map Variable to Input 

File button.  Select the appropriate layer-stacked NDVI input for the variable (in 

this example, B1 is assigned to SWAN_NDVI_2000_sm). 

 

 Proceed through each of the remaining variables (B2 through B6).   

 

 Enter Output Filename (be sure to navigate to the proper destination file folder) 

and click OK.   

 

The result is a stacked image containing the mean NDVI value for each of 23 bands.  

Other statistics may be calculated as well – see the ENVI main menu  Help for Band 

Math for calculating other statistics.  The limits are set only by your creativity with Band 

Math. 

 

 

SOP 2.3.5.2 Create Difference Image  

Required Software:  ENVI 

 

You may create an image depicting the difference between any observation and average 

conditions.  This can be performed either for the entire year (procedure below) or for a 

single composite period.  This procedure is performed using Band Math.   

 

 From the ENVI main menu click Basic Tools  Band Math.  A Band Math 

popup window will appear. 

 

 Within the Band Math popup window, Enter an expression.  For calculating the 

difference between two images, the expression is (B1 – B2).   Assign B1 to the 

year under analysis and B2 to the mean value image.  The result may then be 

displayed using the usual ENVI display SOP. 

 

 Enter Output Filename (be sure to navigate to the proper destination file folder) 

and click OK.   

 

The result is a stacked image containing the difference in NDVI between the year under 

analysis and the mean value for each band.   

 

 

SOP 2.4  Phenology Metrics 

 

Phenology - the study of the timing of biological events (such as spring greenup and fall 

senescence) is an indicator of an ecosystem’s response to a suite of environmental variables, 
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most notably climate.  The role of remote sensing in phenological studies, while still under 

development, is increasingly regarded as a key to understanding large area seasonal phenomena.  

Repeated observations from satellite-borne multispectral sensors provide a mechanism to study 

regional scale phenology and monitor the potential impact of changing phenology on 

ecosystems.  For instance, a trend toward earlier spring greenup may result in earlier animal 

movement. 

 

Remote sensing has been used to study phenology in a research mode from the 1970’s through 

the 1990’s (e.g., Badhwar, 1984; Lloyd, 1990; White and others, 1997; Reed and others, 2003).  

Recent research in remote sensing phenology has primarily been focused on the AVHRR and 

MODIS satellite sensors because of their daily repeat cycles (at high latitudes) and sensor 

configurations that are suitable for vegetation studies.  Because of these characteristics, they 

have the ability for use in deriving remote sensing phenology estimates for operational 

ecosystem monitoring.   

 

Phenological variables that may be estimated from satellite remote sensing are the time of the 

start of the growing season (SOS), end of growing season (EOS) and the growing season length 

(GSL).  When deriving phenological characteristics from remote sensors, the object is not 

species, population, or even community specific phenology, but rather the characteristics of 

individual pixels.  If the pixel size is on the order of hundreds of meters, the objective usually 

becomes characterizing the phenology of a mosaic of several vegetation types.  Because of the 

more general target, the specificity of phenology that can be determined is reduced.  The 

contribution of the individual phenology of the various components of a pixel are mixed and the 

integrated phenology of the pixel is usually addressed in terms of a more general statement such 

as the start or the end of the growing season, rather than more specific measures such as first-leaf 

or bud-burst.   

 

The various approaches that have been used for satellite phenology can be grouped into three 

types; threshold-based, inflection points, and trend derivatives.  Threshold-based measures use 

either a pre-defined or a relative reference value for defining the start of season.  For example, in 

one of the earlier efforts at using AVHRR for setting a definitive date for SOS, Lloyd (1990) 

used a NDVI = 0.099 as the threshold value in a study using AVHRR NDVI data.  When the 

NDVI reached this threshold value, SOS was reached.  Such a reference value can be very 

effective at defining local SOS values, but there is difficulty in using such values over 

environments with different soil background characteristics or with land cover types.  The 

inflection point approach usually involves creating a model to describe elements of the time-

series curve.  One example is Zhang and others (2002), whose algorithm is based on finding 

when the curvature of the NDVI time-series changes from one linear stage to another, i.e. from 

decreasing to increasing or increasing to decreasing sections.  The points with maximal 

curvatures are where the phenology changes phase.  Similar to the previously discussed 

approaches, phenology estimates derived from curve characteristics seek to identify where the VI 

data exhibit a rapid, sustained change.  For example, Reed and colleagues (1994) determine SOS 

by employing a backward-looking moving average.  NDVI values are compared to the average 

of the previous n observations to identify departures from the established trend.  A trend change 

is defined as when the NDVI values become larger than those predicted by the moving average.  

This is the approach used for the SWAN region. 
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While comparing the remote sensing derived start of season values to informally observed dates, 

the remote sensing derived values sometimes seem to be early.  But in some instances, this first 

flush of greenness may not be discernable to the naked eye.  During an early May, 2006 

overflight of the Kenai Peninsula, we were not able to distinguish any greenness (leafed out trees 

or shrubs) with our eyes, however, we noted that moose and bears were actively grazing - 

indicating that green shoots may have been present beneath dead grasses.  These shoots affect the 

surface reflectance measured by the satellite sensor.  Regardless, the technique utilized for this 

study does identify the identical location on the temporal curve for each year of observation, 

thereby supplying a consistent, objective metric for time-series analysis. 

 

 

SOP 2.4.1  Prepare Data for Calculating Phenological Metrics 

Required Software: ENVI 

 

To derive Phenology Metrics for one year, three years of smoothed NDVI data are required.  

This is because the algorithm operates by examining data both before and after the time of 

analysis to identify trend shifts.  When examining the most recent year of observation (a typical 

analysis scenario), there is not yet any data after the time of observation.  In this instance, we 

repeat the current (most recent) year of observation.  Therefore, the first step in this procedure is 

to create a layer stack of smoothed data. 

 

 Assure that the Available Bands List is empty.  On the Available Bands List 

window, click File > Close All Files. 

 

 Open the required files.  On the Available Bands List window, click File > Open 

Image File, open the smoothed files for 2004 and 2005. 

 

 Stack these data using the same procedures as used in SOP 2.3.1.  Stack them in 

the order, 2004, 2005, then 2005 again.  Note that if a complete year of smoothed 

2006 data were available, those data would be used instead of repeating 2005.  

Assure that the data are in chronological order before clicking OK.  Enter 

Output Name:  SWAN-NDVI-040505_sm.  The result is a 69-band file. 

 

Before the phenological metrics can be calculated, two data preparation steps must be performed.  

Some of the calculations in the metrics algorithm require the slope of the NDVI value through 

time as an input variable.  When there is an extended period of time where the NDVI value is 

identical (such as masked values over snow, cloud, aerosol or water), the slope becomes zero.  

This slope value is later used as a divisor in part of the metrics algorithm and crashes the 

program as it currently operates.  Therefore, a workaround is to search for and alter these values.  

We have constructed an ENVI image that can be used as part of an ENVI Math Expression to 

identify and eliminate these constant values.   

 

SOP 2.4.2  Eliminate the extended snow, cloud, or aerosol pixels 

Required Software: ENVI 

 

During the original MODIS processing of NDVI (SOP 2.2) snow, clouds, and high aerosols were 

flagged and written as a value of -4000, which during the transfer to byte data range and the 

smoothing process becomes a value of 90.  Water values in the image also need to be masked in 
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order to avoid nonsensical phenology metrics.  Water values can vary, but generally have an 

NDVI value of 0 (DN of 100) or less. This procedure involves identifying values of less than or 

equal to 100 in the data set and recoding them to values that are near a value of 100 (ranging 

from 100-102) – values that are in the realistic range of NDVI values. 

 

A 69-band image (D:\SWAN\ENVI Expressions\69band-fill), corresponding to 3 years of 

MODIS 16-day data has been prepared containing these values in alternating bands to eliminate 

the constant value issue discussed above.  Before starting the next procedure, assure that the 

69band-fill image has been opened and is in the Available Bands List.   

 

 On the Available Bands List window, click File > Open Image File, open 

D:\SWAN\ENVI Expressions\69band-fill 

 

 Under Basic Tools > Band Math when the Band Math popup window opens, 

select,  

o Restore (this function will restore an existing Band Math expression).  A 

popup window for a filename will open.  Navigate to D:\SWAN\ENVI 

Expressions and select the file BandMath-fill.  This will insert the 

following expression into the Band Math window: 

 byte((B1 le 100) * B2) + byte((B1 gt 100) * B1) 

 

This expression states that if B1 (input smoothed image) is less than or equal to 100 (previously 

masked data values), assign the value of B2 (the fill image containing the 100-102 values).  If 

greater than 100, B1 retains the original values of B1.  The byte portion of the expression assures 

that the data remain in byte range, rather than the default floating point data type. 

 

After clicking OK, a new window will popup that prompts the user to assign variables to the 

expression (Fig. 2.14).   

 

 Make sure that B1 – [undefined] is highlighted, and then press the button Map 

Variable to Input File.  This spawns a new window containing the possible 

input files – select the newly stacked, smoothed image (SWAN-NDVI-

040505_sm).   

 

 Next, highlight the next variable B2 – [undefined] and map that variable to the 

fill file (69-band-fill).   

 

 Choose an output name (SWAN-NDVI-040505-fix).  Press OK. 
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Figure 2.14.  Band Math procedure to “fix” smoothed data prior to calculating phenological metrics. 

 

 

SOP 2.4.2  Calculate and Process Phenological Metrics 

Required Software: IDL, ENVI 

 

 Initiate IDL by clicking on the IDL icon on your desktop 

 

 Assure that the IDL data directory points to the proper path.  From the toolbar at 

the top of the IDL window:  Files > Preferences >  Startup > Working 

Directory – navigate to the location of the smoothed, fixed data created in SOP 

*.*).  Click OK. 

 

 Navigate to the MODIS_software directory.  Double-click the metrics.txt file for 

the appropriate year (2005 in this example – metrics2005.txt).  The text file will 

contain the following expression: 

 

imetricsoncube,'SWAN-NDVI-040505-fix',3483,2783,69,3,22,20,23,1 

 

 Cut and past the command into the IDL command line (Fig. 2.15).  Press the 

Enter key on your keyboard. 
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Figure 2.15.  Placement of the IDL command line. 

 

 

The process takes approximately 3 hours, depending on computer speed and other processes that 

may be running on the computer. 

 

This program outputs 12 files, only a few of which will be used for analysis of the SWAN (Table 

2.3). 

 

 

Metrics Filename Phenological metric 

SWAN-NDVI-040505-fix.eosn End of season NDVI value 

SWAN-NDVI-040505-fix.eost (EOST) End of season time 

SWAN-NDVI-040505-fix.maxn (MAXN) Maximum NDVI value 

SWAN-NDVI-040505-fix.maxt (MAXT) Time of maximum NDVI 

SWAN-NDVI-040505-fix.ndvitodate Accumulated NDVI at last 

observation 

SWAN-NDVI-040505-fix.rangen Range of NDVI values 

SWAN-NDVI-040505-fix.ranget (RANGET) Duration of growing season 

SWAN-NDVI-040505-fix.slopedn Rate of NDVI decrease to EOS 

SWAN-NDVI-040505-fix.slopeup Rate of NDVI increase from SOS 

SWAN-NDVI-040505-fix.sosn Start of season NDVI value 

Insert Command here 
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SWAN-NDVI-040505-fix.sost (SOST) Start of season time 

SWAN-NDVI-040505-fix.totalndvi 

(TOTALNDVI) 

Seasonally integrated NDVI 

 
Table 2.3.  Listing of phenological metrics and their default filenames. 

 

 

The following phenological metrics are being used for SWAN monitoring: EOST, MAXN, 

MAXT, RANGET, SOST, and TOTALNDVI.   

 

 Navigate to the file folder containing the phenology metrics and delete the files 

with the following suffix:  eosn, ndvitodate, rangen, slopedn, slopeup, sosn. 

 

 

SOP 2.4.2.1  Delete padded years of data from the Metrics files.   

Required software:  ENVI 

 

 Initiate ENVI by clicking on the ENVI icon on your desktop 

 

 Open the file that was used to derive the metrics (e.g., SWAN_NDVI_040505-

fix), File> Open Image File 

 

 From the main ENVI window,  File> Open Image File> Select one of the 

phenology files (e.g. SWAN-NDVI-040505-fix.eost).  Because these files were 

created outside of ENVI, header information is required.  A popup window will 

appear with blank spaces for Samples, Lines, Band, etc. 

 

 Click the button “Input Header Info From”, click “Other File…”, select 

“SWAN_NDVI_040505-fix”.  Click OK. 

 

 Edit some of the entries in this window.  The Samples (3483) and Lines (2783) 

are correct.  However, you must change Band from 69 to 3.  Also, the Data Type 

should be changed from Byte to Integer.  Click OK.  You may now use this file 

(SWAN_NDVI_040505-fix.eost) as an “Input Header Info From” for the other 

phenology metrics files. 

 

 From the main ENVI menu, Basic Tools > Resize Data (Spatial/Spectral) From 

the popup window, Select Input File > Highlight 3-band metrics file (e.g. SWAN-

NDVI-040505-fix-eost ) and click Spectral Subset button.  Highlight only Band 2.  

Click OK.  For the Output Filename, Choose: 

 

D:\SWAN\MODIS_VI_16day\2005\Phenology\EOST-2005 

 

Repeat the process for the other phenology metrics. 

 

 

SOP 2.4.2.2  Mask bad data values 
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Required software:  ENVI 

 

In this step, we remove bad data values (due to a poorly defined NDVI “season”) where 

phenology metrics were not satisfactorily identified, so these values do not affect subsequent 

statistical analysis.  The bad values are assigned a value of 0, which will not be considered in 

subsequent steps.  An ENVI Band Math Expression has been created for each of the phenology 

metrics for cleanup. 

 

 Open image file of phenology metric, whose bad data values will be fixed 

 

 Band Math > Restore >  

o Navigate to ENVI Expressions file folder and select EOST-fix (or the 

appropriate metric “fix” expression). 

 

 Highlight expression in Band Math window, click OK 

 

 Assign B1 variable to the Phenology metric file 

 

 Enter Output Filename (be sure to navigate to proper output file folder): 

 

D:\SWAN\MODIS_VI_16day\2005\Phenology\EOST-2005-fix 

 

 

SOP 2.4.2.3  Mask water 

Required software: ENVI 

  

In this step, we mask water values – again, so they are not included in statistical analysis. 

 

 Open image file of fixed phenology metric 

 

 Open the water mask image:  (D:\SWAN\Ancillary_Data\watermask) 

 

 From the ENVI main menu, select Basic Tools > Masking > Apply Mask.  An 

Apply Mask Input File popup window will appear. 

o From the Apply Mask Input File popup, Select the “fixed” phenology 

metric file (e.g., EOST-2005-fix).  Click the Select Mask Band button and 

select watermask file.  Click OK 

o An Apply Mask Parameters window will pop up.  Keep a Mask Value of 

0. 

o Enter Output Filename:  EOST-2005-fixmask. 

 

 

SOP 2.4.3  Interpretation of Phenological Metrics 

Required Software:  ENVI 

 

The phenological metrics data may be displayed and analyzed in ENVI similar to the other data 

sets described earlier.  First the multiple years of a single metric should be layer stacked using 
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procedures described earlier (SOP 2.3.1).  After a stack of a single metric (e.g. SOS) is 

displayed, a Z-profile may be created using SOP 2.3.2 (Fig. 2.16). 

 

  

 
 
Figure 2.16.  End of season day for a pixel in SWAN for years 1 (2000) through 6 (2005). 

 

Such profiles provide information on any trends toward later or earlier ends of season on a pixel-

by-pixel basis.  Although the sample size is currently too small to achieve statistical significance, 

there will soon be a sufficient number of years of observation to perform trend analyses for these 

metrics. 

 

An alternative data set that may be used for such trend analysis is the AVHRR vegetation index 

collection.  An example of such an analysis follows using the Global Inventory Modeling and 

Mapping Studies (GIMMS) AVHRR data provided by NASA at 8-km resolution and dating 

from 1982-2003 (Tucker et al., 2004) (Fig. 2.17).  This database has 15-day NDVI composites 

covering the entire Earth’s surface.  This permits medium-term monitoring of vegetation 

conditions and provides an example of what can be performed for the 250m phenology metrics 

when the data collection grows. 
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Figure 2.17.  NDVI time series (1982-2003) for a pixel in SWAN region. 

 

Phenology metrics may be derived from these data in the same manner as for the MODIS 250m 

collection (Section V).  This results in a much more temporally dense time-series for which 

statistical analyses are appropriate.  Figure 2.18 is an example of the start of season plotted for a 

pixel in the SWAN region for each year from 1982-2003.  A best-fit trend line is plotted through 

the data values and shows a trend toward earlier starts of season for this time period. 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 2.18.  Time of start of season for 1982-2003 for a pixel in SWAN region 

 

A t-test may be performed on the data to determine if the slope of the line is statistically different 

from zero and define a significant linear trend.  The test statistic is defined as: 

 

t = b/s 

 

where b = slope of the best fit line, and s = standard error of the points. 

 

This test may be performed pixel-by-pixel and an image can be created illustrating regions with, 

for example, significantly earlier or later starts of season (Fig. 2.19). 
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Figure 2.19.  Regions in Alaska with significantly earlier (red) or later (green) starts of season. 

 

This kind of analysis may be performed and summarized by different summary units (e.g., 

National Park, ecoregion, watershed, etc.) and updated as new data are collected.  The summary 

units may also be combined (e.g., by land cover type within a watershed) and annual reports 

generated.  This kind of analysis will be possible when a sufficient number of years of data are 

available to achieve statistical significance.   

 

 

SOP 2.5  Generating an Annual Summary Report 

Required software:  ENVI, Excel (or other spreadsheet, database, or statistical package) 

 

To generate annual summary statistics of the phenology metrics, a stratified random sampling 

approach is recommended that will stratify by ecoregions.  ENVI software is used to conduct the 

sampling, and then Excel (or another spreadsheet or database manager) can be used to analyze 

the results.  The steps are to first create the stratified random sample, then to sample the data of 

concern, and finally to analyze the resulting data. 

 

SOP 2.5.1  Create a stratified random sample.   

Required Software:  ENVI 

 

Note that the sample has already been established for the SWAN and the file (Ecoregion-

sample.roi) is placed in the data directory.  However, if the SWAN analysts wish to take a 

different density of samples or use a different sampling scheme, the following procedure will 

permit them to do so. 

 

 Open the image that will be used for stratification – the ecoregions file 

(D:\SWAN\Ancillary_Data\SWAN_summary_eco) 

 

 Under the ENVI main menu, select Basic Tools > Statistics > Generate 

Random Sample > Using Ground Truth Classification Image 

o Select the stratification image (ecoregion file; SWAN_summary_eco) 

 

 Select/deselect any classes that you want (deselect Unclassified) 

 

 You have the option to control the sampling type as Random/Stratified  
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Random/Equalized or Random (Select Stratified Random) 

 

 Select the stratification as proportionate or disproportionate (select proportionate) 

 

 Select the Minimum Sample Size as a percent or as number of pixels (select 

Percent) 

 

 Change the percent to 0.5.  This number was selected to meet the requirement to 

be at the 95% confidence level that the results are within an error of 2 days.  This 

can be adjusted according to the analysts needs.  

 

 You may view the sample size for each class by clicking on the view class sample 

sizes button 

 

 Output to a Single ROI (region of interest) or Multiple ROIs (select Multiple)  – 

this will isolate the results by ecoregion 

 

 Enter Output ROI Filename (e.g., Ecoregion-Sample.roi) 

 

 Click OK 

 

SOP 2.5.2  Sample the data set of interest; 

Required Software:  ENVI 

 

 Open the image you wish to be sampled 

 

 Under Basic Tools, Select Region of Interest > ROI Tool 

 

 Assure that there are no ROIs currently listed in the window 

o Select All > Delete 

 

 Restore the ROI file that you created in the previous step (Ecoregion-Sample.roi) File 

> Restore ROIs… 

o Navigate to D:\SWAN\Ancillary_Data directory and select Ecoregion-

sample.roi 

 

 File > Output ROIs to ASCII… 

o Select the image that you wish to be sampled (EOST-2005-fix). 

  In the Output ROIs to ASCII Parameters window, Select all items  

 

 Output filename:  EOST-2005-stats.txt 

 

SOP 2.5.3  Summarizing the resulting data; 

Required Software:  Excel (or other spreadsheet, database, or statistical package) 
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Analyzing the resulting data requires working with off-the-shelf software, such as Microsoft 

Excel or some other spreadsheet, database, or statistical software package.  The scenario given 

here is for using Microsoft Excel. 

 

 Initiate Excel 

 

 Open the text file created in the previous step using Excel, File > Open, navigate to 

proper file folder and select proper file for analysis (e.g. EOST-2005-stats.txt). 

 

 When the Text Import Wizard initiates, Choose the file type that describes your data 

> select Delimited, click Finish 

 

The spreadsheet will then open with a description of the file, followed by the data.  It is best to 

create new worksheets for each ecoregion to ease the analysis.  The first step is to examine the 

top of the file and gain an understanding of the file structure.  The top of the file will look 

something like in Fig. 2.20. 
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Figure 2.20.  Excel file contents after importing statistical output text file. 

 

 

The top of the file describes class-by-class (ecoregion-by-ecoregion) the number of points that 

were sampled.  For example, Class 1 contains 484 points.  The next step of the process involves 

cutting and pasting class-by-class the data points into a new worksheet. 

 

 Highlight with your cursor the data for Class 1 (484 points in this example).  Note 

that there is a blank row in the spreadsheet between each class’ data (Fig. 2.21). 
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Figure 2.21.  Cutting and pasting data, class-by-class. 

 

 

 Right-click on the highlighted data and select Cut. 

 

 Open a new worksheet and paste the data you have just cut.  On the Excel 

window, select Insert > Worksheet.  A new worksheet will appear. 

 

 Right-click on the first row/column (1A) and click Paste.  The data will appear in 

the first column.  In this example, these are the end-of-season dates that were 

sampled from the EOST-2005-fix image.  It is a good idea to rename the 

worksheet (by highlighting and replacing the worksheet name) with the ecoregion 

name and/or number 

 

 Since we earlier masked out the bad data with 0’s, some of the data will need to 

be eliminated before statistics can be run.  Sort the data from low to high 
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o Highlight the data column 

o Select Data > Sort… (select the column that contains the data) 

o The data will be sorted from low to high.  Now highlight the rows that 

contain 0’s and right-click and select Delete. 

 

To calculate statistics, use standard Excel functions to calculate the appropriate statistics (e.g., 

Average, STDEV). 

 

These summary statistics can then be placed into Table form and compared between ecoregions 

and between years for each of the phenology metrics. 

 

 

Quality Assurance/Quality Control and Validation 

 

Quality assurance and control is a major element of the original MODIS product development 

(before the Landscape Processes Protocol is implemented).  For a summary of the types of 

processing QA/QC that have been implemented, see an overview of the Land Data Operational 

Product Evaluation (http://landweb.nascom.nasa.gov/cgi-bin/QA_WWW/newPage.cgi).  
Similarly, many of the standard MODIS products have undergone validation experiments.  The 

MODIS Land Processes Validation web site summarizes many of these efforts 

(http://landval.gsfc.nasa.gov/index.php). 

 

While the quality of the MODIS data is evaluated using the QA information outlined above, 

validation of data analysis and interpretation, in terms of actual SWAN landscape processes, 

requires a much more intensive effort.  The issue of validating satellite derived measures of these 

various processes is beyond the scope of this protocol and will need to be addressed by SWAN I 

& M staff as further investigations are undertaken.  There are low-cost options for documenting 

landscape processes such as start of season (e.g., documenting plant development in the 

Anchorage area), but a full-scale (network-wide) validation effort would be very difficult and 

labor intensive.  It may be possible to identify a small localized area that could be evaluated as a 

test validation site for each of the standard MODIS products. The feasibility of such a validation 

site will be evaluated by SWAN personnel during the initial protocol implementation.  

Therefore, no formalized procedures for validation of data analysis and interpretation are 

included in this protocol. 
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SOP 3:  Snow Cover Extent 
 

 

Satellite-Derived Measures of Landscape Processes 

Southwest Alaska Network 

  

Standard Operating Procedure (SOP) # 3 

 

Snow Cover Extent 
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Update on Oct 13, 2006:  During protocol testing, the authors found that the 8-day MODIS 

Snow Cover Extent product (MOD10A2) was, in some cases, overestimating the extent of snow 

pack.  Daily snow cover products were assessed and compared to the 8-day composite to confirm 

that more area was being flagged as snow than was present in the daily images.  Therefore, the 

authors have addressed this issue by acquiring daily snow cover data (MOD10A1) throughout 

the history of the Terra satellite to supplement the 8-day composites. Both daily and 8-day 

composite data will be acquired.  The authors recommend processing both the daily and 8-day 

products, using the dailies as a supplement to the 8-day data to resolve conflicts and to identify 

more specific days of snow occurrence.  The current data set of MODIS Terra daily snow cover 

extent begins on Julian day 055 of 2000 to present. 

 

The processing of MODIS Snow products should be performed according to the processing 

schedule outlined in Table 3.1. 

 

 

Action SOP Frequency 

Data Acquisition 3.1 Twice Monthly 

Daily Snow processing 3.2 Twice Monthly 

8-day Snow processing 3.3 Twice Monthly 

Data Visualization /Analysis 3.4 Monthly/Yearly as needed 

Summarizing / Reporting 3.5 Monthly/Yearly as needed 

 
Table 3.1  MODIS Snow processing schedule. 

 

Software and scripts that are required to run this set of SOPs are listed in Table 3.2 

 

Software Process 
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File transfer protocol (ftp) File transfer 

List_HDF List of HDF file names (.txt) 

MRT Process HDF files 

Snow Processing Scripts Process Snow Files 

ENVI Image Visualization/Analysis 

Excel (or other spreadsheet) Reporting 

 
Table 3.2.  Software required for processing MODIS Snow data. 

 

 

3.1.  Data Acquisition Procedures 

Required Software: FTP client 

 

Acquisition of MODIS 8-day and daily snow cover data from the National Snow and Ice Data 

Center (NSIDC) DAAC (http://nsidc.org/daac/) will utilize the NSIDC “data pool” which allows 

users to download files via FTP.  At the time of writing the NSIDC policy was to stage all 

current and historical data on the data pool indefinitely. 

 

3.1.1. MODIS 500m Daily Snow Cover Extent Data (MOD10A1) 
 

 Using either a command line prompt or an FTP client, access the NSIDC data pool at the 

following location: 

 

ftphost:   n0dps01u.ecs.nasa.gov 

username:   anonymous 

password:   your email address 

ftp directory:   SAN/MOST/MOD10A1.004 (daily collection 4) 

    

 

  Navigate to the daily directory from which you want to download data.  The daily 

directories are named using the following format: yyyy.mm.dd, where yyyy equals a four 

digit year, mm equals a two digit month, and dd equals the two digit calendar day.   

 

 Download only the HDF files necessary for coverage of the SWAN parks (i.e. h09v02, 

h09v03, h10v02, h10v03, h11v02, h11v03) to the daily MODIS Snow directory.  The 

filenames begin with MOD10A1.A2006293 (four digit year and 3 digit Julian day), 

followed by the horizontal and vertical tile locations.  An example of a complete filename 

is shown below.  

 

MOD10A1.A2006293.h09v02.004.2006298153221.hdf 

 

 

 

 

3.1.2. MODIS 500m 8-Day Snow Cover Extent Data (MOD10A2) 
 

 Using either a command line prompt or an FTP client, access the NSIDC data pool at the 

following location: 
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ftphost:   n0dps01u.ecs.nasa.gov 

username:   anonymous 

password:   your email address 

ftp directory:   SAN/MOST/MOD10A2.004 (8-day collection 4) 

    

 Navigate to the 8-day directory from which you want to download data.  The 8-day 

directories are named using the following format: yyyy.mm.dd, where yyyy equals a four 

digit year, mm equals a two digit month, and dd equals the two digit calendar day. 

 

 Download only the HDF files necessary for coverage of the SWAN parks (i.e. h09v02, 

h09v03, h10v02, h10v03, h11v02, h11v03) to the 8-day MODIS Snow directory.  The 

filenames begin with MOD10A2.A2006293 (four digit year and 3 digit Julian day), 

followed by the horizontal and vertical tile locations.  An example of a complete filename 

is shown below.  

 

MOD10A2.A2006293.h09v02.004.2006298153221.hdf 

 

If the desired data are not staged on the NSIDC data pool, see Appendix 3 for information on 

ordering via the EOS Data Gateway (EDG). 

 

 

3.2.  Daily Snow Cover Processing 

Required Software: List_HDF, MRT, Daily Snow Processing Scripts 

 

 Once the MOD10A1 HDF files have been retrieved from the NSIDC FTP site and reside 

on the local SWAN machine, run the List_HDF.exe script provided in the MODIS 

software directory (e.g. D:\SWAN\MODIS_software).  Double click on the executable 

file to open a small dialog box.   

 

Using the dropdown file structure, point to the directory where the HDF files are 

located and click ok (Fig. 3.1).  This will create a text file named with the four digit year 

and three digit Julian day of the HDF files (i.e. 2006293.txt).  

 

Note:  Many MODIS files are named according to their Julian Date.  Julian day is simply 

the sequential day number, starting from Jan 1 and running through Dec 31.  Julian 

dates will change during leap years. 
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Figure 3.1.  An example of the List_HDF dialog box. 

 

 Execute the batch file SWAN_daily_maxsnow_script.bat found in the annual directory 

where data is being processed (D:\SWAN\MODIS_SNOW_daily\2006 in this example).  

The batch file will process only those files for which text files (created using List_HDF) 

and raw HDF files exist.   

  

The execution of this batch file will launch an MS-DOS window that shows the progress of 

the processing.  Since the batch file is written to process a complete year, it will flash a 

number of error screens for dates that have already been processed or are not yet available. It 

uses command line MRT processes to extract the maximum snow extent data set (data set [or 

band] 1) from the daily MODIS snow product, mosaic the individual tiles, and apply the 

predefined projection parameters for the SWAN region to the output image (see Appendix 1 

for these parameters). 

 

 The result is a GeoTIFF image with the following pixel classification values (Table 3.3): 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Table 3.3.  Classified pixel values for maximum snow extent products. 

 

 

 

 

 

3.3.  8-Day Snow Cover Processing 

Required Software: List_HDF, MRT, 8-Day Snow Processing Scripts 

 

Processing the 8-day MODIS Snow Cover data is identical to the steps used in section 3.2 for the 

daily data. Use the same procedures, substituting MOD10A2 and 8-day for MOD10A1 and daily. 

 

 

Value Classification 

0 Missing 

1 No Decision 

3 Scan Angle Limit Exceeded 

4 Erroneous Data 

11 Night 

25 Snow-Free Land 

37 Lake or Inland Water 

39 Open Water (ocean) 

50 Cloud Obscured 

100 Snow-Covered Lake Ice 

200 Snow 
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3.4.  Data Visualization / Analysis 

Required Software: ENVI 

 

The visualization and analysis of the MODIS snow cover products is largely exploratory.  In 

addition to viewing the classified snow cover images and assessing the spatial extent of snow 

cover on either a daily or an 8-day time step, we have also established some basic methods for 

analysis.  These include exploiting the high temporal frequency of the daily data using profiles of 

the daily time series and quantitatively summarizing the extent of snow cover within a defined 

zone using the 8-day composite data.  The following procedures will be used: 

 

   1) Visualization of the Daily and 8-day composite data. 

   2) Layer stacking and Z-profiles of Daily data. 

   3) Quantification of 8-day extent by ecoregion. 

 

3.4.1.  Snow cover Data Visualization 

 

 Start ENVI by double clicking the desktop icon 

 

 Select File > Open Image File and navigate to either the daily or 8-day snow directories 

where the GeoTIFF outputs were written for a given year (SOP 3.2 or 3.3) and select a 

.tif file.  The selected file will be displayed in the available bands list. 

 

 Select Band 1 > Load Band with the grayscale button selected.  A black and white 

classified image (Fig. 3.2) will be displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 3.2.  Display of an 8-day snow cover image in 3 ENVI windows. 
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 Since the black and white classified image isn’t very meaningful, apply a color map to 

the image so individual classes can be distinguished.  From the large display window 

select Tools > Color Mapping > Density Slice, select Band 1. 

 

 From the density slice dialog box select File > Restore Ranges and navigate to the 8-day 

or daily snow cover directories and select the SWAN_maxsnow.dsr file and click Apply. 

 

 The .dsr file contains color assignments for each of the classification values in the image 

(Table 3.3).  The values will generally be in the range from 25 – 200 as seen in Fig. 3.3, 

where green is snow free land (25), light blue is inland water (37), dark blue is ocean 

(39), gray is cloud (50), aquamarine is snow-covered lake ice (100), and white is snow 

(200).  Not all classes are represented in each image. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 3.3.  Display of an 8-day snow cover image with the color map (.dsr) file applied. 

 

 

 If you are uncertain of a pixel value or want to explore the image in more detail, you can 

use the Cursor Location/Value option under the Tools menu of the large display window 

and navigate with your cursor to view the latitude/longitude and classification values of 

individual pixels. 
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3.4.2.  Layer Stacking and Z-Profiles of Daily Data 

 

As a means of utilizing the high temporal frequency of the daily snow cover data it may be 

useful to stack an entire year of daily data into an annual stacked image.  These can then be 

assessed using the Z-profile tools on a per pixel basis to identify specific dates of snow on / off 

times, snow persistence, cloud persistence, etc. 

 

The procedures for layer stacking and producing Z-profiles are outlined below. 

 

 Start ENVI if necessary 

 

 Select File > Open Image File and navigate to the annual directory where daily imagery 

is located.  Select all images that you want to stack using the shift key to select multiple 

images.  The available bands list will include all the images selected (this could take a 

little while to populate if you’re doing a complete year of 365 images). 

 

 From the Basic Tools menu select Layer Stacking to launch the layer stacking 

parameters window.  Select the Import File button and select the list of files that you 

loaded into the available bands list (Fig. 3.4), again using the shift key to select multiple 

images and click ok. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 3.4.  Layer stacking parameters box and list of input files for stacking. 

 

 After the files have been loaded into the selected files listing, select the Reorder Files 

button to show the temporal (chronological) order in which the images will be stacked. 

The default will list the files in descending order with day 365 as the first file, day 364 as 
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the second and so on.  Reverse the order of the images to be chronological by holding the 

cursor over the file names and clicking the center mouse button. The files will now be 

in order from 1 – 365 (Fig. 3.5). Click ok. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 3.5.  Reverse file order by clicking the middle mouse button over the file listing. 

 

 

 Enter an output filename > 2005_snowstack > click ok. 

 

 The layer stack image will display in the available bands listing when completed.  

Display one band of the image by selecting a band and clicking load band. Apply the 

colormap (.dsr) file to assign color to the image if desired. 

 

 You are now displaying one band of a 365-band image.  To view the Z-profile of the 

daily snow cover time series select Tools > Profiles > Z- profile (spectrum). 

 

The spectral profile displays for the single pixel where the cursor is located (Fig. 3.6).  As you 

move the mouse over the image, the profile changes for each pixel selected.  It should be noted 

that the Z-profile for the classified snow cover image is quite different from a more continuous 

measure such as NDVI.  The profile of the classified image varies greatly from day to day as a 

single pixel may be classified cloud then snow then cloud all in the span of a 3 day period.  
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Figure 3.6.  Spectral profile of a single pixel from one year of stacked snow cover data. 

 

 

The example in Fig. 3.6 for 2005 shows that this pixel was largely snow covered (values of 200) 

or cloud (values of 50) until approximately day 125 (5 May).  The pixel was cloud or snow-free 

land (values of 25) through day 287 (14 October). 

 

Layer stacking and the Z-profile tools allow a quick per pixel assessment of the snow cover time 

series.  This may be a useful tool for pinpointing more specific snow on/off dates than can be 

obtained from the 8-day maximum snow extent data. 

 

 The values that make up the profile can be easily saved to a text format for importation to 

a spreadsheet by selecting File > Save Plot As > ASCII from the profile window. 

 

The example above illustrates the pervasive influence of cloud on the daily image acquisitions.  

The very nature of a temporal composite, such as the 8-day snow cover, assists in minimizing 

cloud effects and may represent a more suitable product for quantifying snow cover extent within 

a specified zone. 

 

 

day 125 day 287 
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3.4.3. Quantification of 8-day Snow Cover Extent by Ecoregion 

 

This portion of the SOP will outline the procedures for quantifying the spatial extent of snow 

cover every 8 days using the composite snow cover product and selected ecoregions throughout 

the SWAN parks and surrounding areas.  Stratification by ecoregion was determined to be the 

most suitable for summarizing snow cover measurements.  Detailed procedures for summarizing 

an 8-day period are outlined below. 

 

The procedure uses the Confusion Matrix function in ENVI.  This function compares a 

classification result with ground truth information.  In this case, we will use the ecoregions as a 

classification and the MODIS 8-day snow cover image as the ground truth information.   

 

 Start ENVI if necessary 

 

 File > Open Image File and navigate to D:\SWAN\MODIS\Snow_summary.  Load the 

SWAN_summary_eco.tif file to the available bands list. 

 

 The confusion matrix requires that the inputs be ENVI classification files, therefore you 

need to edit the ecoregion header from TIFF to ENVI Classification.  To do this select 

File > Edit ENVI Header and select the ecoregion file from the input file list.  In the 

header info dialog box, select File Type > ENVI > Classification.  In the number of 

classes box that opens, change the number to 10 classes and click ok (Fig. 3.7).  The 

ecoregion file used in this example contains 9 classified ecoregions and 1 ‘no data’ class. 

Click ok in the “class colormap editor” box and the “header info box”.  

 
 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 
Figure 3.7.  Conversion of TIFF image to ENVI Classification image. 

 Display the ecoregion classification image by selecting Band 1 > Load Band and you 

will see each ecoregion is assigned a different color (Fig. 3.8). 
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Figure 3.8.  Example of an ecoregion classification image. 

 

 

 Open the 8-day snow cover image that you want to summarize from the 

MODIS_Snow_8day directory (File > Open Image File).  

 

The 8-day image file also needs to be converted to an ENVI classification image.  Rather 

than summarizing all possible classes in the snow cover product, we will only summarize 

Land (class 25), Cloud (class 50), and Snow (class 200).   We will reassign values of 1, 2, 

and 3, respectively, to each of these classes.   

 

The following outlines this procedure. 

 

 

 From the Basic Tools menu, select Band Math.  We have provided a band math 

expression that will convert the land class to values of 1, the cloud to values of 2, the 

snow to values of 3 and all other classes to unclassified.   

 In the band math box select restore and navigate to the 

D:\SWAN\MODIS\Snow_summary directory.   

 Select the snow_bandmath.exp and click open.  The expression will be loaded to the top 

of the band math dialog box.   

 Highlight the expression and click ok.  

 In the next box that opens, select the map variable to input file button, select the 8-day 

snow image that you loaded (SWAN_2004297.Maximum_Snow_Extent.tif in this 

example) and click ok (Fig. 3.9). 
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Figure 3.9.  Mapping the band math equation to a specific snow cover image file. 

 

 

 At the bottom of the variables to bands pairings dialog box that opens, select the choose 

button to assign an output filename and location.  Click ok and the new image is added to 

the available bands list.  

 

 Edit the ENVI header of the new image from ENVI standard to an ENVI Classification 

file type.  Use the same procedure outlined above for converting the ecoregions file from 

TIFF to ENVI Classification.  Although we only have 3 valid classes and 1 ‘no data’ 

class, select 10 as the number of classes (the confusion matrix requires that both the 

classification and the ground truth image have the same number of classes – a 

symmetrical matrix).   

 

 Run the Confusion Matrix Function on the two classification images by   

selecting Classification > Post Classification > Confusion Matrix > Using Ground 

Truth Image.   

 In the Classification Input File box, select the ecoregion file as the classification input 

and click ok.   

 In the Ground Truth Input File box, select the four-class snow image created in the 

previous step as the ground truth and click ok.   

 Click ok in both the match class parameters box and the confusion matrix parameters 

box. 

 

The output is a matrix that includes the 9 ecoregion classes along the left margin and the 

number of pixels for each of the four classes (unclassified, land, cloud, and snow) that are 

present in each ecoregion (Fig. 3.10).  Note that the non-existent classes in the snow image 

(classes 4 – 9) show values of 0 for each summary ecoregion.  The sum of the 4 classes 

identifies the total number of pixels within that ecoregion. 
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Figure 3.10.  Confusion matrix output summarizing 3 classes of the MODIS 8-day Snow Cover product by 

ecoregion. 

 

 From the confusion matrix output, select File > Save text to ASCII for importation to a 

spreadsheet program. 

 

 

3.5.  Summarizing / Reporting 

Required Software: Excel (or other spreadsheet, database, or statistical package) 
 

Summarizing and reporting of MODIS snow cover extent data could be performed in several 

possible ways.  Once the data are in ASCII form, they may be input into a number of 

spreadsheets, databases, or statistical packages for a variety of reporting scenarios.  Following is 

one method of summarizing the output from the confusion matrix. 

 

Figure 3.11 illustrates a spreadsheet that could be created for each ecoregion that would facilitate 

the incremental tracking of snow cover.  As each 8-day period of snow cover is assessed by 

ecoregion, the results from the confusion matrix could simply be input to a spreadsheet that 

would convert the pixel counts to a percent cover and plot those on a time series graph. 
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Figure 3.11.  Example of a possible reporting mechanism for the quantification of snow cover within an 

ecoregion. 

 

 

The example of the Cook Inlet Basin in Fig. 3.11 illustrates the onset of the snow season 

showing nearly 100 percent snow-free land during period 257, followed by corresponding 

decreases in land and increases in snow during the next 8-day period (265).  Early season 

variability in all three classes is evident for the latter periods beginning at period 281. 

 

During the initial phase of the protocol implementation, SWAN I & M staff will evaluate these 

analysis techniques and develop more detailed methods of reporting that coincide with ecological 

monitoring objectives.  
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SOP 4: Lake Ice 
 

 

Satellite-Derived Measures of Landscape Processes 

Southwest Alaska Network 

  

Standard Operating Procedure (SOP) # 4 

 

Lake Ice 

 

Revision History Log: 

Previous 

Version # 

Revision 

Date 

Author Changes Made Reason for Change New 

Version # 

      

      

      

      

      

 

This SOP explains the procedures for browsing, acquiring and processing daily MODIS 

calibrated radiance images and interpreting them for lake ice metrics.  Many other features and 

processes will be evident as the images are examined for lake ice.  This SOP requires 

downloading, processing and archiving daily calibrated radiance images of 250m data for bands 

1 and 2 (red and near infrared).  These images will be archived as single band geotiff images in 

the SWAN image archives.   

 

The processing of MODIS Calibrated Radiance products for lake ice metrics should be 

performed according to the processing schedule outlined in Table 4.1. 

 

Action SOP Frequency 

Data Browse 4.1 Daily-weekly 

Data Acquisition 4.2, 4.3, 4.4 Weekly-monthly 

Data Processing 4.5, 4.6 Monthly 

Interpretation of ice cover 4.7 Monthly 

Ice season metrics 4.8 Yearly 

Annual comparision/trends 4.9 Yearly 

 
Table 4.1  MODIS calibrated radiance processing and ice metrics interpretation schedule. 

 

The software packages that are required to run this set of SOPs are listed in Table 4.2. 

 

Software Process 

Internet Browser Data search and order 

File transfer protocol (ftp) File transfer 

MRTSwath Georectification 

ENVI Display, mosaic and enhance  
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Photoshop Additional enhancement, image 

viewing and interpretation 

Photo manager such as ACDSee Rapid image viewing, image 

labeling and management 

Excel (or other spreadsheet) Data recordation and reporting 

ArcMap Digital calibration of ocular 

estimates 

 
Table 4.2.  Required software for processing calibrated radiance data and interpreting ice metrics. 

 
SWAN is located in an extremely dynamic region of Alaska.  Maritime and continental climate 

regimes meet over the SWAN.  Climatic patterns are exacerbated by topographic relief and 

peninsulas that extend into the North Pacific Ocean and Bering Sea.  Ice metrics on large lakes 

and lake complexes are indicators of the cumulative thermal regime across SWAN  (Jeffries et al 

2005, Latifovic and Pouliot 2006).  A warming climatic trend should lead to shorter ice-bound 

seasons on lakes, while overall colder climate will lead to longer ice seasons.  These trends will 

likely vary spatially across SWAN and be reflected in different lakes.  The objective of this 

protocol is to determine the natural variability in ice season in SWAN and detect long term 

trends in ice season duration and freeze-up/break-up dates. 

 

Lake ice metrics are interpreted from daily MODIS calibrated radiance images.  Lake ice metrics 

are freeze-up date, break-up date and duration of ice season, freeze-up season and break-up 

season.  These metrics are derived from ocular estimates of ice cover on selected lakes across the 

SWAN region.  Calibrated radiance images are the MOD02 data and corresponding MOD03 

georectification files.  

 

The complete list and general descriptions of MODIS products are found at multiple websites.  A 

simple overview is at:  http://modis.gsfc.nasa.gov/data/dataprod/index.php 

 

Download, process and archive a MODIS MOD02QKM image for EVERY DAY.  Sometimes 

multiple images (ie an Aqua and a Terra image) may be processed for a single day.  Feel free to 

collect images that range outside the SWAN region if they show events or features which affect 

SWAN.   
 

4.1. Data Browse   

 

There are several browse facilities for MODIS data.  The easiest one to use is the Rapidfire site 

maintained by NASA Goddard: http://rapidfire.sci.gsfc.nasa.gov/production/.  

 

Thumbnails of every MODIS image are displayed by Julian day and Zulu time.  Terra images are 

at the top of the web page, and Aqua images at the bottom.  Using the Julian calendar at the top 

of the webpage, select the date of interest.  The website then displays all images available for 

that day.  There are roughly three passes per day for Alaska by each satellite:  an eastern 

overpass centered over SE Alaska, a central overpass often centered over SWAN, and a western 

overpass over the Bering Sea and Aleutians.  These images are acquired late in the Zulu-time 

day:  usually between 20:00 and 23:50 hours.  This roughly corresponds to late morning local 

time. The swaths are chopped up into five second pieces called granules.  Review the thumbnails 

http://modis.gsfc.nasa.gov/data/dataprod/index.php
http://rapidfire.sci.gsfc.nasa.gov/production/
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on the right of the page for Terra, and the left for Aqua.  You can usually recognize SWAN by 

the arc of the Gulf of Alaska or the line of the Alaska Peninsula and the Aleutians.   

 

Double clicking a thumbnail will display a natural color version of the image in a separate 

window with the default resolution of 1 km.  If desired, you can download larger images (up to 

250m resolution), or other band combinations or products (e.g., NDVI or color infrared).  

Although these images are not geometrically corrected, quite a bit of information can be 

interpreted from these raw images when the area of interest is in the center.  The edges of these 

images are distorted due to the bow-tie effect of the sensors.  They can be downloaded as 

uncorrected jpegs.   

 

1. Use these thumbnails to select dates and times for further downloading and analysis or to 

interpret large scale features and phenomena across the SWAN region.  Record the Zulu 

time of the granule.  It may be necessary to select two granules if the images are split 

directly over SWAN.   

 

2. Other browse sites include: 

 University of Alaska Fairbanks Geophysical Institute (swath-based images, 

mostly summer.  Primary application is for wildfire.)  

http://www.gina.alaska.edu/page.xml?group=data&page=alaska_images 

 http://landweb.nascom.nasa.gov/cgi-bin/browse/browse.cgi 

 Snow and Ice products http://modis-snow-ice.gsfc.nasa.gov/intro.html 

 (hint:  check out the Gallery at http://rapidfire.sci.gsfc.nasa.gov/ for the pick of 

the day’s amazing images from around the world.  It will give you ideas of what 

you can see with MODIS data.) 

 

4.2.  Data Search 

 

Use the LAADS web page to select and order the exact granules (files of SWATH data) for 

the SWAN every day. 

   http://ladsweb.nascom.nasa.gov 

o Data 

o Search (see Fig 4.1 for the entry screen).  Note that you have limited time 

to fill out and submit this screen.  (5 minutes) 

 

 Product Selection 

 Select Aqua or Terra 

 Group = Level 1 products 

 Products: select desired products, usually MOD 

(MYD)02QKM and MOD(MYD)03 

 

Note:  File naming conventions assign MOD to Terra and 

MYD to Aqua. 
 

 Temporal Selection 

 Type = individual dates 

http://www.gina.alaska.edu/page.xml?group=data&page=alaska_images
http://landweb.nascom.nasa.gov/cgi-bin/browse/browse.cgi
http://modis-snow-ice.gsfc.nasa.gov/intro.html
http://rapidfire.sci.gsfc.nasa.gov/
http://ladsweb.nascom.nasa.gov/
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o yyyy-ddd (julian day) or mm/dd/yyyy (calendar 

day) 

 Collection Selection = 5 

 Spatial Selection 

 Coordinate system = latitude/longitude 

 A new screen appears, enter bounding coordinates for 

SWAN 

North = 62 

     West = -160   East = -146 

       South = 56 

 Coverage Selection 

 Day   

 Both (necessary for low sun angle days where part of the 

granule is white on the thumbnail.  NASA assigns “night” 

to portions of the granule with low sun angles.) 

 (uncheck night) 

 

 Metadata Selection 

 Filtering = off  for both PGE and QAPercent 

 Uncheck box that says “Require that the filtered metadata 

fields be defined to be included in the search results” 

o Click SEARCH 

 

Note—as of 12/06, the Save and Load functions are not working on Windows 

OS. 
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Figure 4. 1. Search for SWAN calibrated radiance granules using LAADS website. 

4.3.  Data Order 

The search function returns all granules (SWATH chunks) for the day and area specified.  For 

each granule, a thumbnail should be available by clicking the appropriate “view RGB” on the 

right side of the screen.  Uncheck the granules (images) you DONT want,leaving checked the 

images you do want.  This is where it is useful to have the zulu time of the pass that best covers 

SWAN.  It helps narrow down the granules of interest.  When you have finished your searching 

and selection, press “order data now” at bottom of screen (Fig 4.2). 

 

 
Figure 4. 2.   Search results for calibrated radiance granules.  Retain checks for desired granules and 

associated geolocation files. 

 

Another screen appears (Fig 4.3):  fill out your email address 

Select delivery method:  check FTP Pull 

Press Order 
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Figure 4. 3. Screen to specify email and delivery method. 

4.4. Data Download 

Required Software:  ftp 

a. If your selected granules are available online, you will get a message with an order number 

(Fig 4.4).  Click on the Order id:  ############## to get details of your order (Fig 4.5)> 

 

Figure 4. 4. Order number for online granules. 
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Figure 4. 5. .  Details of granule order on LAADS website.  Use this information to download data. 

b. You will receive two emails from the ladsweb.  The first one is an order confirmation and 

gives your order ID (duplicates screen for online data).  The second email tells you where 

your data are posted.  Older data have to be reprocessed before posting.  This will be referred 

to as POD (processing on demand), and may take a day or two (or sometimes a week).  The 

geolocation files (MOD03 or MYD03) will usually be available immediately.  It is 

recommended to keep a log of order numbers and file names as it is easy to lose track of the 

data and associated geolocation files if they are available several days apart. 

Order Notification email: 

 
Your Order ID is: 500016314 Make a note of this number, you need it for downloading 

The data you ordered has been staged, and you can retrieve the data 

through anonymous FTP using: 

   ftp ladsftp.nascom.nasa.gov 

   username: anonymous 

   password: Page_spencer@fws.gov 

 

   cd /orders/500016314 

   binary 
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   prompt 

   mget * 

Note: The files will be deleted after 7 days, please download the files before they get 

deleted. 

c. You will need FTP software to get your data from the LAADS web.  Either use the regular 

FTP command that comes with Windows, or download one you prefer.  A very useful one 

has been NcFtp, available for free downloading from www.ncftp.com.  NcFtp displays the 

download progress for each file, which is very useful as you download these large files.  

Regular FTP doesn’t give progress reports, and sometimes you are not sure the connection is 

still working. Another good one is WS_FTP  (http://www.ipswitch.com/Products/WS_FTP/).  

It cost $90, but has a nice GUI and is not as prone to timing out as regular FTP or even 

NcFtp. 

Note:  DO NOT USE WINDOWS COPY and PASTE commands—it takes a long time and the 

connection will often time out.   

For Nctp:  

 Open a DOS Command window:   

StartAll ProgramsAccessoriesCommand Prompt 

 Change to the drive on your computer where you want to save your files (drive letter 

and a colon) 

Example:  >j: 

 Change (cd) to the directory on your computer where you want to save your files 

Example:  > cd  {name of directory} 

 

Note: For help using DOS, type “help” at the > prompt, and a list of commands will 

appear.  The command cd  .. will take you up up a level in the directory tree structure, 

and that cd pathname will take you down or across the directory tree structure. 

 

 ncftp to the FTPHOST site: 

Example:  ncftp ladsftp.nascom.nasa.gov 

 cd to the FTPDIR 

Example:  cd /orders/500016314 

 

Note:  the order number comes in your email from LAADS or the order details screen. 

 

 ls to list files   

 get all the files: 

Example:  mget *.* 

 

The files will start downloading.  The ETA: counter shows approximate time remaining for that 

file.  This process can take a long time.  If a connection is fast, you may get them at the rate of 

one .hdf file every 20-30 minutes.  This is a good thing to do at the end of the day.  DO NOT 

CLOSE the DOS WINDOW!  If all goes well and the connection doesn’t break, you should have 

your files by the next day (Fig 4.6). When the files are finished downloading, type quit to exit the 

http://www.ncftp.com/
http://www.ipswitch.com/Products/WS_FTP/
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ftp program. You will then have a data file (MOD02QKM) and a geolocation file (MOD03) for 

every granule you selected. 

 

 
Figure 4. 6.  DOS Command Prompt window for data downloads.  Example with ncFTP software. 

 

4.5. Data Processing 

Required Software:  MRT Swath 

 

1.  Geometric Correction (Reprojection)   

The MRT Swath Reprojection Tool can be found at the home page for the Land Products 

DAAC (http://LPDAAC.usgs.gov/main.asp ) under Data Tools.  Download the software and 

install it per the instructions on the web site and SOP 1.  You must process the unrectified 

MOD02 files using the MOD03 geolocation files.   Proceed with displaying, stretching and 

enhancing.  Note that the effects of the atmosphere have not been removed from this product; 

http://lpdaac.usgs.gov/main.asp
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smoke, water vapor and various spectral scatterings will affect the data values.  However, the 

spatial patterns are valid, and should not show the well-intentioned artifacts of automatic 

aerosol correction and path selection. 

Run the MRTSwath using the shortcut you created during installation.  A black window 

labeled MODISTool.bat comes up, quickly followed by the MODISTool GUI.  Fill out the 

GUI screen as follows (Fig 4.7): 

 Open Input File  --  navigate to the directory where you saved the downloaded SWATH files 

(hdf files).  Select the desired MOD02 .hdf files.  The Input File Info box is automatically 

populated by the MRTSwath.   

 All the bands in your hdf tile files are displayed in the “Selected Bands” box on the right.  

Put the files you DON’T want over in the “Available Bands” box on the left by selecting 

them and pressing the << button.  You should keep the bands labeled xxx_b0 and xxx_b1.  

These bands are the spectral data, and the b# corresponds to the band number of the MODIS 

sensor.  See http://LPDAAC.usgs.gov/modis/table2.asp or Table 2.1 in the Protocol Narrative 

for a listing of band numbers and their corresponding wavelength ranges. 

 Spatial Subset:  Input lat/long 

1. UL corner is 62 latitude, -160 longitude 

2. LR corner is 56 latitude, -146 longitude 

 These are the boundaries of the SWAN region.   

 Specify corresponding MOD03 geolocation file.  Match up Ayear/julianday/zulutime of data 

collection, which is the first date number in the hdf file name, not the second.  The second set 

of numbers that starts with the year is the processing time. 

http://lpdaac.usgs.gov/modis/table2.asp
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 Specify Output File:  

browse to directory 

where you are putting 

projected files and 

specify file name 

(SWAN_yyyyddd.tif).  

Be sure to add the .tif to 

the filename.  The 

MRT will add the band 

number and product 

type to whatever you 

specify as a root file 

name.  (see sidebar and 

SOP 5 for directory 

structure and file 

naming conventions.  

 Output file type is 

GEOTIFF 

 Resampling Type is 

Nearest Neighbor 

 Output Projection Type 

is Albers Equal Area 

 Edit Projection 

Parameters: 

SMajor : 0.0  

SMinor : 0.0  

STDPR1 : 55.0 

STDPR2: 65.0  

CentMer: -154.0  

OriginLat: 50.0 

FE : 0.0  

FN : 0 .0  

Ellipsoid:  GRS 1980 

 Output datatype is same 

as input datatype 

 Output pixel size is 

whatever you 

ordered (250m, 

500m or 1000m) 

 Press Run button.  A 

Status window appears and tracks the processing for each band.  The MRTSwath writes 

the final files to the directory and name specified in the Output File window.  You will 

have a geotif image for each spectral band you specified in the Selected bands window. 

The images and interpreted derivatives will be stored under the following directory structure:   

  Drive name:\AREA\SENSOR_ProductType(or metric)_TimePeriod 
i. Year 

a. Files 

Drive name will be the drive letter (e.g, D:\, J:\) plus any higher level directories (e.g., 
J:\SWAN\Remote_Sensing) 

 

AREA will be the geographic area of interest, usually “SWAN”, but may also be “AllAlaska”, 
or other networks or areas of interest.   

 

SENSOR will be “MODIS” or “ASTER” 

 

ProductType will include  
 SNOW 

 SurfRef500 

 SurfRef250 

 VI 

 CalRad500 

 CalRad250 
 Phenology  

SnowCover  

LakeIce  
TimePeriod will be the time period represented.  Currently these include 

 1day 

 8day 
 16day 

 

Year subdirectories will be the calendar year 
 

File names will use the following convention: 

 
a. Image file names :   

AREA_YearJulianDay.ProductType_IdentifyingInfor

mation.FileType 
b. Input files and output files such as .txt or .prm files for automated processing 

are named by their scripts, or provided by USGS EROS.  These will reside in 
the appropriate year directory. 

 

 AREA will usually be “SWAN”, but may also be “AllAlaska” or other 
networks or areas of interest. 

 

 YearJulianDay will be four digit year followed by the three digit Julian 
day.  Remember that for multiple day composites, the Julian day is the 

first day of the composite. 

 

 ProductType will be sur_refl, cal_rad, VI, etc.  Many of these files will 

be named during the mosaicking and reprojecting by the MRTs, as 

discussed in SOPs 2 and 5. 

 

 IdentifyingInformation will vary depending on the stage of processing 

the file represents.  The MRT will append the band number in this 
position.  Other likely information may include enhancements, band 

stacks, stretches, density slices, smoothing, or a host of interpretation 

processing.  There will often be multiple fields in the filename for this 
information.   

 

 FileType will be the three letter suffix which identifies the file type.  
These often identify the program that generated the file, such as .doc for 

Word files, or .xls for excel spreadsheets.  Many of the data files will be 

GeoTiff  or Tiff (.tif) files generated by the MRT, ENVI and/or 
Photoshop during processing.  Files downloaded from the LP DAAC will 

be .hdf or .aux.hdf.  These are the raw MODIS files before they are 

processed by the MRT.  Standard ENVI files will not have a suffix, but 
will be paired with a header (.hdr) file.  
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Figure 4. 7. MRTSwath Graphical User Interface for data processing. 

 

2. Image building and Enhancement 

Required Software:  ENVI 

This step uses ENVI software to stack the bands into a single file.  ENVI may be used for further 

enhancing, or you may export a .tif file for enhancing with a package such as Photoshop.  Using 

ENVI retains the georeferencing and individual spectral bands, so the image can be used in 

various GIS software or for further image analysis functions.  Using Photoshop creates a color 

image where the red/green/blue channels are no longer spectral data, but simply color values of a 

picture.  Photoshop may be used to create graphics for interpretation, posters or publications 

where the actual spectral data values are no longer needed. 

 

The steps required are as follows: 

1. Open calibrated radiance (MOD02 swath – output from SOP 4.5) data in ENVI software 

2. Display as natural color or color infrared false color composite 

3. Stack data into multi-band image  

4. Mosaic sub-images into one SWAN image 

5. Enhance for manual interpretation 



12/15/06 Satellite –Derived Measures of Landscape Processes 

SOP 4 - Version 1.00 

104 

Open the files in ENVI 

In the Main ENVI menu, select File  Open Image File.  Select desired bands (*.tif files) from 

the geometrically corrected list for standard SWAN calibrated radiance products.  The file names 

should be displayed in a pop-up window entitled Available Bands List. 

Display as natural color or infrared false color composite.   

Natural color or color infrared displays can be made using the 500m calibrated radiance data.  

Specify the appropriate bands from the available bands list and load RGB.  Color infrared 

displays can also be created using the 250m calibrated radiance data. 

For example, the file names (individual bands) for one date may be: 

SWAN_2004001.cal_rad_b01 

SWAN_2004001.cal_rad_b02 

where SWAN_2004001.sur_refl_b01 is calibrated radiance from year 2004, day 001, and bxx 

represents band number.  To display the various band combinations, select the RGB option on 

the Available Bands List and assign the color (R,G,B) guns as follows: 

Natural color  

 Red gun band 1 

 Green gun band 4 

 Blue gun band 3 

False color infrared  

 Red gun band 2 

 Green gun band 1 

 Blue gun band 4 (or repeat band 1 with 250m data) 

Stack data into multiband image 

There are several methods to stack the individual bands into a single image (which then becomes 

easier to handle).  One method is as follows:  from the ENVI main menu, select File Save file 

as ENVI standard.  The ENVI standard file will be a flat binary file with an associated header 

file (*.hdr).  Stack as many bands in the file as you will want to work with.  The suggestion here 

is to stack 500m bands 1,2,3, and 4 for one date into a single image or 250 m bands 1 and 2 into 

a single image.  The resulting file will be a multi-band image of the SWAN region.  You can use 

this to proceed with ENVI processing, including various stretches and other enhancements.  This 

is the image for archiving in the SWAN data set.  If one granule doesn’t cover the entire SWAN 

region, mosaic additional granules and save the final two-banded image that covers SWAN. 
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Image Mosaicking 

It may take more than one SWATH granule to cover the entire SWAN region.  Download and 

process as many granules as necessary to cover SWAN (usually 2).  Then mosaic the images to 

form one image of SWAN for each day. 

 In ENVI—at main menu 

 Basic ToolsMosaickingGeoreferencedImportImport files and edit properties 

 Select or browse to one of the SWAN images.  After it displays in the little image 

window, select the other file.  They should each display in the mosaicking window.  Be 

sure to keep the same spectral stretch for all files.  Use the appropriate value for 

background pixels to set to transparent so you don’t have black patches in your mosaic.   

 Then go to Fileapply in the mosaicking window.  Specify an output image name.  

4.6.Enhance image for manual interpretation 

The calibrated radiance data that are produced using SOPs 4-1 through 4-5 may be used for 

interpretations regarding vegetation development, land use/land cover change, ice development 

and break-up, and other applications.  The basic approach toward interpreting the data is to 

import the data into ENVI, create time-series imagery, and compare the data to previous years’ 

observations for periodic reporting (e.g., annual, decadal).  

Enhance display image (this does not change actual data values, only the display).  Using the 

Display Image Menu, select Enhance.  Using the scroll window as the target, the preprogrammed 

stretches for Linear 2% and the Square Root make a quick and often useful enhancement.  

Another useful enhancement is in the Main ENVI Menu:  Transform  Photographic Stretch.  

This stretch has cleaned up images with several “foggy” bands and results in a clean appearing 

image. 

For finer tuning of specific features, use the interactive stretching at the bottom of the menu.  In 

the histogram window menu:   

a. Stretch_TypePiecewise Linear 

b. Add nodes to the white stretch line in the histogram with the middle mouse button 

c. OptionsEdit Piecewise Linear 

d. Enter new (output) values for each node in the right column (LUT Val). Different 

LUT values may be used for experimentation until a suitable enhancement is 

achieved. 

For real color enhancement:  (this does change the actual data values of the images).  In the 

Display Image Menu, select Enhance  Interactive Stretching.  The default stretch is Linear 

Stretch.  To make each of the bands consistent choose the radio buttons (R, G, and B) 

individually and change the stretch values to 0 : 2500.  After changing the stretch value for a 

single radio button (e.g., R), click the Apply button (Fig 4.8)   
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Repeat the same stretch for the green (G) and blue (B) bands. 

For the false color infrared images, use a stretch of 1: 10000 and follow the same steps. 

Export the files in tif, .bmp, or .jpg formats if you want to work with them in graphics or text 

packages.   These formats can be read by Photoshop, Powerpoint, or other graphics packages and 

word processing packages.  To export an ENVI display to one of these formats, do the following:  

 Right mouse click in the display window.   

 In the pop-up window, select “Save image as”.   

 Under “Output File Type, select desired format (tif, bmp, jpg ).   

You may open the resulting file in Photoshop and use the Image Adjustments functions to 

enhance the color balance, brightness and contrast.   

4.7. Interpret freeze-up and break-up on selected lakes in the SWAN Region.   

Required Software:  Photoshop  (or equivalent), ArcMap 

The current method for analyzing ice on and off of lake systems is by manual interpretation.  The 

analyst examines the images in the region of the lakes and makes a determination about the stage 

(% cover) of ice on the lake.   

Ice appears as white on both natural color and CIR images, so solid snow covered ice is easily 

interpreted.  Likewise, open water is predominately black or dark blue on both image 

composites, with lighter blue or bluegreen signifying a sediment load in the water.  Open water is 

Figure 4. 8. Recommended linear stretch values for calibrated radiance images. 
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easily interpreted from natural color and CIR images.  Wet ice, such as may occur during break-

up or by overflow on solid ice, appears pale blue (blue ice). Wet ice is often mottled with white 

and black, reflecting the ice and water mosaic.  Another form of blue ice is when the frozen over 

lake is wind swept during winter storms.  Cracks often show in the ice, indicating that you are 

looking at ice rather than open silty water.   

During freeze-up, ice may form during cold weather, break apart and refreeze, often several 

times before the lake is frozen over for the winter.  During break-up, parts of large lakes will 

often melt out earlier than others.  Sometimes, large pans of free ice will be blown around the 

lake by strong surface winds, changing the pattern of ice distribution from day to day.  Smaller 

lakes and pond complexes exhibit different freeze-up and break-up patterns.  Many small 

shallow lakes will ice over early in the winter, while nearby deeper lakes do not freeze over until 

later, if at all.   

MODIS images from the 2004-05 ice season are presented in Plates 4.1 and 4.2 for Lake Clark 

and Iliamna Lake.  Notes in the captions for each plate are examples of various ice and 

environmental features the interpreter is likely to encounter while evaluating ice conditions on 

lakes in SWAN.   

1. Indicator lakes for ice cover in SWAN at the MODIS resolution include (Plate 4.3): 

 Brooks/Naknek Lakes complex (Katmai NPP) 

 Lake Clark (Lake Clark NPP) 

 Lake Grosvenor (Katmai NPP) 

 Lake Colville (Katmai NPP) 

 Telaquana Lake (Lake Clark NPP) 

 Twin Lakes (Lake Clark NPP) 

 Kukalek (Katmai NPP 

 Nonvianuk (Katmai NPP) 

 Becharof and Iliamna on the Alaska Peninsula 

 Tustemena and Skilac on the Kenai Peninsula 

 Beluga and Chakachamna Lakes in the Alaska Range 

 Complexes of small lakes in the lower Susitna Valley and the northern Kenai 

Peninsula  

 Bristol Bay 

2. Interpretation of lake ice cover.  Examine the calibrated radiance images and make ocular 

estimates of ice cover on lakes listed above in 10% increments.  For each day and each lake or 

complex, record the data in a file as shown in Table 4.3 (excel file for Julian day/lake).  Note 

cloud cover (c) if clouds cover lake.  Frequently, clouds will cover part, but not all of the SWAN 

region.  If you can’t see a specific lake, try the next day (and the next), until you can find a 

cloud-free image over the lake.  Sometimes you can interpret ice and water through scattered or 

thin clouds.  

3. Digital Calibration.  Periodically, check your ocular estimates with a digital calibration of 

an image.  Select a (relatively) clear date with partial ice cover on lakes across the region as your 

calibration image.  This is accomplished by masking out the lakes of interest, making an “ice 
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classification” by density slicing, and calculating % of signatures which should represent ice and 

water.   

 Select a lake(s) that are cloud and shadow free;  only water and ice  

 Use registered swath MOD02 data 

 Use lake masks created at the raster size of your data 

 In ArcMap:  add mask files and IR band of MOD02 image, (01 band) 

 Clip out lake using raster calculator 

o Outfile name = con([lakemask) > 0, [NearIRband file]) 

o Evaluate,  say YES if projection error 

 Display lakesymbolizeclassification (3-7 classes depending on ice) 

 View histogram, set breaks 

o Water is approximately 100-1250 

o Ice should be > 1250 

 Color code image—check that it seems realistic for water and ice patterns 

 Raster calculation to make a binary image 

o Output = lake mask > 1250 

 View attribute table for this grid to count number of cells that are ice  

o (ice = 1) 

o Total lake area = 1s and 0s 

 Calculate % of ice for total lake area 

o # pixels =1/total number of pixels in lake 

 Compare with ocular estimate, adjust estimates accordingly 

 Document for files, including date, interpreter and image date. 

 If any actual verification data exist, compare with image conditions  (check with 

pilots in area, go fly around yourself) 

  Interpret ice season metrics 

 Required software:  ENVI, Excel 

Examine the lakes using the interpretation criteria outlined in section 4.6.2 and Plates 4.1 and 

4.2.  Determine the date(s) of initial freeze-up (ice on part of lake(s)), final freeze-up (ice over 

whole lake), beginning break-up (ice pans or wet ice), final break-up (no ice, all open water), and 

lengths of freeze-up season, ice-on season, break-up season and ice-free season (the following 

summer).  Record these metrics for each lake or lake complex individually.  The data set for each 

cycle of seasons will appear as in Table 4.4.  In time, there should be sufficient data to establish 

the range of natural variability, and to conduct trend analysis to see if there are long term trends 

in ice seasons. 

Initial freeze-up ≥10% ice cover on lake 

 Freeze-up season final – initial dates (number of days) 

Final freeze-up  >90% ice cover 

 Ice on season beginning break-up – final freeze-up (- interim days in winter) 

Beginning break-up ≤90% ice cover, often leads or cracks appearing, wet blue ice 

 Break-up season final break-up – beginning break-up 

Final break-up  <10% ice cover on open water 

 Ice free season Final break-up to initial freeze-up 
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Plate 4.1.  Ice season on Lake Clark, Dec 2004-May 2005.  These subimages are taken from 

Rapidfire images which are not geometrically corrected.  Therefore, ice coverage estimates 

pertain to these images only, and may be significantly different when using geocorrected 

calibrated radiance images.  The images in the plate are full data resolution.  Although features 

may be difficult to see on a printed plate, expand or zoom the digital file to observe features 

noted in the captions. These are examples for illustration only. 

 
a. Dec 20, 2004.  Solstice on Lake Clark.  The only ice is in upper Chulitna and Portage Bays.  

Remainder of lake is open water.  Note mountain shadows across lake.   

b. Dec 28, 2004.  Ice covers Chulitna and Portage Bays around Keys Point.  Light fog on lake near 

Portage Creek.  Kontrashibuna is still open water.  Ice cover 10%.  Record as initial freeze-up. 

c. Jan 10, 2005.  Ice patterns similar to Dec 28, 2004. Ice cover 10%. 

d. Jan 18, 2005.  Ice with new snow on lower Lake Clark below Cape Shiskin.  Open water shows 

outboard of Port Alsworth; low fog covers upper Lake Clark.  Little Lake Clark is frozen over and 

snow covered.  Ice cover approximately 30%, assuming open water below fog. 

e. Jan 27, 2005.  New ice on western Lake Clark; note white cracks in ice.  Probably open water from 

lower Keys Point up to Port Alsworth.  Fog over upper lake and valleys. 

f. Feb 1, 2005.  New ice (no snow) on most of lower lake west of Port Alsworth.  Ice pans on lake west 

of Tommy Island.  Open water on middle and upper Lake Clark.  Kontrashibuna iced over.  Ice cover 

30-40%. 

g. Feb 2, 2005.  Ice pans on middle Lake Clark expanding and coalescing. Fog at upper end.  Ice cover 

70%. 

h. Feb 3, 2005   Ice cover nearly complete;  90%. 

i. Feb 4, 2005.  Ice cover complete 100%;  freeze-up date.   

j. Feb 11, 2005 Ice cover complete.  New snow from storm Feb 5-9. 

k. Feb 19, 2005.  (note—b/w image), ice cover wind swept.  Snow blown to western end. 

l. Mar 4, 2005.  Several storms since Feb 19.  Windswept “blue ice”. 

m. Mar 11, 2005.  Beginning of break-up.  “Blue” ice on lower and middle Lake Clark.  Open water or 

very wet ice on upper Lake Clark.  Scattered clouds over lake (note shadows.)   

n. Mar 18, 2005.  New snow on ice at lower end of lake.  Middle Lake Clark breaking up—large ice pans 

and wet blue ice.  Ice cover approximately 60%.  Blue ice on Little Lake Clark. 

o. Mar 23, 2005.  Some ice outboard of Port Alsworth has refrozen since March 18.  Middle and upper 

Lake Clark generally ice free.  Thin clouds over most of scene.  Ice cover less than 50%.  New snow 

on Little Lake Clark ice. 

p. Mar 26, 2005.  Scene covered by thin clouds.  Barely interpretable as open water in mid-upper lake, 

snow covered ice on lower lake. 

q. Mar 29, 2005.  Open water mid-upper Lake Clark.  Large pans breaking off east of Cape Shishkin.  

Solid ice cover on lower lake.  Ice approximately 40%.  Little Lake Clark starting to break-up. 

r. Apr 3, 2005.  Ice pans coalesced and refroze east of Cape Shishkin.  Ice still about 40%.  Little Lake 

Clark about half open water.  Kontrashibuna still ice covered.  Note open patch at outlet of Lake Clark. 

s. Apr 10, 2005.  Continued slow break-up between Cape Shishkin and Port Alsworth.  Ice on lower lake 

has faint bluish cast.  Ice cover pushing 30%. 

t. Apr 12, 2005.  Similar to Apr 10.  Note higher lakes Kontrashibuna and Upper Tazimina starting to 

develop blue ice.  Little Lake Clark almost completely ice free.  

u. Apr 17, 2005.  Similar to Apr. 10. 

v. Apr 24, 2005.  Lower lake still ice bound.  Note westward retreat of ice in channel between Cape 

Shishkin and southeast shore of Lake Clark.   

w. Apr 28, 2005.  Ice in lower lake getting fairly rotten.  Ice cover less than 30%.  Upper Kontrashibuna 

and Tazimina Lakes breaking up.  

x. Apr 30, 2005.  Similar to Apr 28, but ice is “bluer” and has open patches in lower lake.  Ice cover still 

about 30%.  Kijik still frozen. 

y. May 7, 2005.  Clouds covered the scene during the first week in May, preventing pin pointing the 

exact day of break-up.  Completely ice free on this date.  Record as open water.  Kontrashibuna, 

Taziminas, Kijik all open.  Lots of cumulus clouds and shadows. 

z. May 9, 2005.  Nice cloud free day showing all lakes except Long Lake as open water. 
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Plate 4.2.  Ice season on Iliama Lake, Dec 2004-May 2005.   
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These subimages are taken from Rapidfire images which are not geometrically corrected.  

Therefore, ice coverage estimates pertain to these images only, and may be significantly different 

when using geocorrected calibrated radiance images. The images in the plate are full data 

resolution.  Although features may be difficult to see on a printed plate, expand or zoom the 

digital file to observe features noted in the captions.  These are examples for illustration only. 

 
a. Dec 20, 2004.  Open water with cloud strings near south shore. 

b. Dec 28, 2004.  Early skims of ice near outlet at western end.  Ice <10%. 

c. Jan 10, 2005.  Very new ice on western end/middle of lake. Thin clouds. Ice 50-60%.  Record as initial 

freeze-up. 

d. Jan 18, 2005.  Ice thickening, but pushed westward by wind.  Freezing in around islands at upper end.  

Swirls of broken ice off Kaknonak. Thin clouds on western end.  Ice 40-50%. 

e. Jan 27, 2005.  Ice formation moving east.  Upper and south lake covered with low fog.  Difficult to 

estimate ice cover; probably about 50%. 

f. Feb 1, 2005.  Ice breaking and refreezing in middle section; western section pretty stable.  Ice scrim 

forming among islands at upper end.  Ice cover 60-70%. 

g. Feb 2, 2005.  Continued ice formation near middle, especially near mouth of Newhalen River.  Ice 

cover 70-80%. 

h. Feb 3, 2005.  Ice extent about same as Feb 2, but more stable on north shore.  Cover 80%. 

i. Feb 4, 2005.  Continued ice development, especially Pile Bay.  Ice cover 90%. 

j. Feb 11, 2005.  Complete ice cover except tiny holes near south shore.  A storm Feb 5-9 covered area 

with new snow.  Record as freeze-up. 

k. Feb 19, 2005.  Wind swept ice still mostly intact.  Note that holes from Feb 11 are slightly larger.  Ice 

cover still pretty much complete. 

l. Mar 4, 2005.  Continued wind swept ice cover since Feb 19.  Ice cover still >>90%. 

m. Mar 11, 2005.  Cloud covered; difficult to interpret beyond appearance that ice is still intact. 

n. Mar 18, 2005.  Beginning of break-up.  Large open area along south shore at eastern end and Pile Bay.  

Large cracks and pans forming at eastern end.  Ice cover 80-90%. 

o. Mar 23, 2005. Cloudy.  Appears to be new snow on ice. 

p. Mar 26, 2005.  Thin clouds, but break-up clearly visible.  Open water is black, many large pans and 

leads.  New snow on ice.  Note opening at outlet.  Ice cover 50-60%. 

q. Mar 29, 2005.  Continued break-up and rearrangement of large ice pans.  Note large area of open water 

(a polyna?) at western end, and refrozen pans immediately east of it.  Also note beginning of 

characteristic “three leaf clover” open water at upper end.  Ice 70%.  Thin clouds. 

r. Apr 3, 2005.  New ice reforming in western open water area.  “Clover” more definitive, upper Pile Bay 

open, while channel off Porcupine Island has refrozen.  Ice cover back up to 80%. 

s. Apr 10, 2005.  Much of lake refrozen; new ice covers western polyna and Pile Bay.  Ice cover back to 

90+%.   

t. Apr 12, 2005.  Break-up resumes.  Polyna open on northern shore, “clover” and Pile Bay open water.  

Ice cover 80-90%. 

u. Apr 17, 2005.  Continued break-up across lake.  Large areas of open water on northwestern shore, note 

rearrangement of ice pans.  Upper open clover merged with Pile Bay.  Ice 70-80%. 

v. Apr 24, 2005.  Movement of ice pans by wind and possible new ice along northwestern shore.  Thin 

crescent of clouds on south shore.  Ice 30%. 

w. Apr 28, 2005.  Continued break-up of western ice pack.  Leads and large pans.  Most ice gone from 

south and eastern end.  Ice cover 20%. 

x. Apr 30, 2005.  Last of the ice pushed onto western shore.  Clouds across middle and eastern end of 

lake.  Ice cover 10%. 

y. May 7, 2005. Last remnant of ice along western shore.  Clouds scattered over western end.  Record as 

open water; ice cover about 2%.  

z. May 9, 2005.  Nice cloud free day with tiny remnant of ice on western shore.   
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Plate 4. 3.  Locations of lakes for ice cover monitoring in SWAN.  MODIS image August 11, 2005
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   c=clouds; #=%ice; blank-not interpretable or not on image     

year 
Jul 
day date Iliamna 

Lake 
Clark 

Twin 
Lks Skilac Tustemena Notes, other observations    

2005 364 30-Dec            

2005 365 31-Dec            

2006 4 4-Jan 5 10 80 0 0       

2006 5 5-Jan c 10 80 0 0       

2006 6 6-Jan            

2006 7 7-Jan            

2006 8 8-Jan            

2006 9 9-Jan            

2006 10 10-Jan            

2006 11 11-Jan c c c c c       

2006 12 12-Jan            

2006 13 13-Jan 
50, ice 
pans 40 c 50 0 Augustine multiple ash clouds drifting SE   

2006 14 14-Jan            

2006 15 15-Jan            

2006 16 16-Jan            

2006 17 17-Jan 

40, big  
ice 
pans 20 c 100 30 Arctic high meets Pacific low at Ak Pen along Aleutian Mtns  

2006 18 18-Jan 70 c 100 c c ash to west of Augustine, over east end of Illiamna   

2006 19 19-Jan 
70, ice 
pans 50 100 100 c Augustine has steam plume, Tustemena, Lk Clark, Iliamna all partially frozen 

2006 20 20-Jan            

2006 21 21-Jan            

2006 22 22-Jan            

2006 23 23-Jan 100 100 100 100 50 Cloud streaks N and S of Ak Pen    

2006 24 24-Jan 100 100 100 100 100 Ice in Bering Sea south fo Aklun Mtns, Bristol Bay to Pilot Pt  

2006 25 25-Jan            

2006 26 26-Jan 100 100 100 100 100 King's Bay, PWS frozen over    

2006 27 27-Jan            

2006 28 28-Jan 100 c c 100 100 Cloud streaks across Bering Sea and  Ak Pen, low in Gulf,  

2006 29 29-Jan 100 100 100 c c Augustine plume blowing up through clouds, blowing SW,  

2006 30 30-Jan 100 100 100 100 100 Augustine plume blowing NE; ash deposits (?) S of Kamishak Bay 

2006 31 31-Jan            

2006 32 1-Feb 100 100 100 c 100 Great cloud streaks off Bering Sea, Ice in Bering Sea reaches south of Naknek. 

2006 33 2-Feb 100 100 100 100 100 Augustine plume blowing west, Bristol Bay iced down to Aniakcha 

2006 34 3-Feb c c c 100 100 Copper R delta--appears to be ground water flow out ot delta gravels 

2006 35 4-Feb            

2006 36 5-Feb            

2006 37 6-Feb            

2006 38 7-Feb            

2006 39 8-Feb c c 100 100 100 Skilac and Tustemena blown mostly snowfree, blue ice  

2006 40 9-Feb c c c c c       

2006 41 10-Feb            

2006 42 11-Feb            

2006 43 12-Feb c c c c c       

2006 44 13-Feb            

2006 45 14-Feb c 100 c 100 100 Skilac & Tustemena wind blown, blue ice, King's Bay frozen  

2006 46 15-Feb c c c 100 100 watch Skilac--breaking up around upper landing?   

2006 47 16-Feb 100 80 100? 90 100 very new ice on most lakes    

2006 48 17-Feb            

2006 49 18-Feb            

2006 50 19-Feb            

2006 51 20-Feb c c c 60 90       

2006 52 21-Feb 100 c c 60 90 Skilac freezing, thin ice Tust, Illiamna, Becharof   

2006 53 22-Feb 100 100 c 60 100 Skilac just freezing, Tust thin ice, Naknek and Illiamna thin ice  

2006 54 23-Feb            



 

 

2006 55 24-Feb 100 100 100 95 100 Skilac nearly frozen over, west end still blue   

2006 56 25-Feb            

2006 57 26-Feb c c c 100 100 East end of Skilac still grey--just frozen   

Table 4. 3.  Example of data record for ice cover.  Ice season 2005-06. 
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Table 4.4.  Example data reporting for lake freeze-up/break-up cycle. 

4.9. Compare to other years 

For example, Figure 4.9 illustrates the differences between 8-day calibrated radiance for 

Feb 18-25 from 2001 and 2004.  It is obvious that there is considerably more snow and 

ice in 2004, with Lake Iliamna and Lake Clark under ice and snow. 

 

 

Years of 

ice cycle 

2004-05 

 

 

 

  dates by Julian calendar Number of Days 

Lake 

initial 

freeze-up 

Interium 

melting/ 

freezing final 

freeze-

up 

beginni

ng 

break-

up 

Interium 

melting/ 

freezing final 

break

-up 

length 

of 

freeze-

up  

length of 

ice-on or 

cover 

season 

length 

of 

break-

up 

season 

length of 

ice-free 

season 

(following 

summer) 

Lake Clark  362    035  070    127 38  35  57 203 

Iliamna  010    042  077 100 102  127 30  35  48 203 

             

Tustemena                     

Skilac                     

Bleuga                     

Chakachamna                     

Twin Lakes                     

   

  

    

 

         

  

 

Ice Cycle  

2005-06  

  

  

 

      

Lake Clark 330 
  

023 131 
 

 142 28 108 11 193 

Iliamna 330 
  

023 134 
 

 149 28 111 15  

             

Tustemena             

Skilac             

Bleuga             

Chakachamna             

Twin Lakes             
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Figure 4. 9. Differences in ice cover on Illimna Lake between Feb. 18-25, 2001 (left) and 2004 (right). 

 

When comparing same-date imagery from two (or more) different years, it is helpful to 

link the display windows from the two years.  This is performed in the following manner.   

 

 Open and display a specified date’s calibrated radiance data using ENVI 

software (SOP 4.6.2).   

 Open and display the same date from another year using a second display 

window.  

  

 To open a new display window, click on the display selection 

button (Fig. 4.10), and select New Display.   

 A new display will then be available to for the second year of data.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 4. 11.  Specify new display window for year 2. 
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After the two images are displayed, they may be linked by right mouse-clicking in either 

window and selecting “Link Displays…”.  Multiple displays may be linked in this way 

(assuming that they are georeferenced in the same manner).  After they are linked, the 

zoom boxes may be moved with the mouse for any one window and they will move in an 

identical manner in the linked windows. 

 

Reporting 

 

Annual summary reports and synthesis reports that outline trends in landscape processes 

will describe the metrics shown in Table 4.5. 

 

 

Vital sign Metrics 

Lake ice For a given lake: 

 date of initial freeze-up  

 date of final freeze-up - continuous ice 

 date of initial break-up 

 end of break-up-- ice-free 

 duration of freeze-up season 

 duration of ice season 

 duration of break-up season 

 duration of ice-free season 

 range of freeze-up and break-up dates, 

seasonal durations across SWAN region 

 
Table 4.5.  Reporting summary for lake ice metrics. 
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SOP 5: Data Management-NPS 
 

 

Satellite-Derived Measures of Landscape Processes 

Southwest Alaska Network 

  

Standard Operating Procedure (SOP) # 5 

 

Data Management-NPS 

 

Revision History Log: 

Previous 

Version # 

Revision 

Date 

Author Changes Made Reason for Change New 

Version # 

      

      

      

      

      

 

Data Management Procedures 

 

4-1. Directory Structure and File Naming   

 

The images and interpreted derivatives will be stored under the following directory 

structure:   

 Drive name:\AREA\SENSOR_ProductType(or metric)_TimePeriod 

i. Year 

a. Files 

Drive name will be the drive letter (e.g, D:\, J:\) plus any higher level directories 

(e.g., J:\SWAN\Remote_Sensing) 

 

AREA will be the geographic area of interest, usually “SWAN”, but may also be 

“AllAlaska”, or other networks or areas of interest.   

 

SENSOR will be “MODIS” or “ASTER” 

 

ProductType will include  

 SNOW 

 SurfRef500 

 SurfRef250 

 VI 

 CalRad500 

 CalRad250 

 Phenology  

SnowCover  

LakeIce  

TimePeriod will be the time period represented.  Currently these include 
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 daily 

 8day 

 16day 

 

Year subdirectories will be the calendar year 

 

 

File names will use the following convention: 

 

a. Image file names :   

AREA_YearJulianDay.ProductType_IdentifyingInformation.FileType 

b. Input files and output files such as .txt or .prm files for automated 

processing are named by their scripts, or provided by USGS EROS.  

These will reside in the appropriate year directory. 

 

 AREA will usually be “SWAN”, but may also be “AllAlaska” or 

other networks or areas of interest. 

 

 YearJulianDay will be four digit year followed by the three digit 

Julian day.  Remember that for multiple day composites, the Julian 

day is the first day of the composite. 

 

 ProductType will be sur_refl, cal_rad, VI, etc.  Many of these 

files will be named during the mosaicking and reprojecting by the 

MRTs, as discussed in SOPs 2 and 5. 

 

 IdentifyingInformation will vary depending on the stage of 

processing the file represents.  The MRT will append the band 

number in this position.  Other likely information may include 

enhancements, band stacks, stretches, density slices, smoothing, or 

a host of interpretation processing.  There will often be multiple 

fields in the filename for this information.   

 

 FileType will be the three letter suffix which identifies the file 

type.  These often identify the program that generated the file, such 

as .doc for Word files, or .xls for excel spreadsheets.  Many of the 

data files will be GeoTiff  or Tiff (.tif) files generated by the MRT, 

ENVI and/or Photoshop during processing.  Files downloaded 

from the LP DAAC will be .hdf or .aux.hdf.  These are the raw 

MODIS files before they are processed by the MRT.  Standard 

ENVI files will not have a suffix, but will be paired with a header 

(.hdr) file.  
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Although the SWAN Data Management Plan recommends that there be no periods (.) in 

filename, the raw datafiles and many of the products from the scripts have periods in the 

names.  Use the underline (_) in file and directory names as specified above.   

 

 

4-2.  Metadata   

 

Metadata will follow the FGDC (Federal Geographic Data Committee) format.  One 

metadata record per product type (cf. 4-1) will be produced to meet the FGDC Content 

Standards for Digital Geospatial Metadata (CSDGM). The metadata records should cite 

this protocol in the “Larger Work Citation” An example of an acceptable metadata file is 

attached as Appendix 2.   

 

A metadata file will be put in each product type directory (cf. 4-1), and will apply to all 

images in those directories.  The only variable for subdirectories will be the date the data 

were originally acquired by the satellites. See the SWAN Data Management Plan, 

Sections 8.2 and 8.4, for SWAN standards for documentation of spatial data sets. 

Metadata for interpreted products will document the procedures used to analyze and 

interpret the images.  Essential documentation such as algorithms, output files, or spatial 

analyses may reside in different systems and formats, and could potentially be 

overlooked when distributing or applying the data.  Depending on the project, 

documentation may need to include details on data models or algorithms used, 

procedures for data synthesis, and associated input and output files.  Data use and data 

request histories, and secondary research or publications resulting from long-term 

monitoring projects, may also need to be tracked (cf. SWAN Data Management Plan 

2005, Section 8.6.2).  As the protocols are developed, vital signs documentation will be 

tested and will evolve to combine metadata needs and ease of use.   

 

 

4-3. Operational and Archiving File Management     

 

Raw files will be downloaded from the LP and NSIDC DAACs and LAADS to a 

working computer (e.g., external drive, D:\).  Reprojected, mosaicked files (.tif) will be 

transferred to the SWAN file server (J:\).  It may not be practical to use the J:\SWAN 

server for operational processing because the NPS network is too slow to process large 

image files.  Final MODIS products will be archived on the AKRO data file server (X:\). 

The directory and file structure should be set up on each involved computer to mirror the 

structure outlined in procedure 1 above.  Filenames will follow the conventions outlined 

in procedure 4-1.  These conventions will allow for easier transfer to the SWAN server.   

 

Each of the data processing scenarios will require the creation of temporary files that will 

not be needed for long-term monitoring of the SWAN.  To preserve disk space and to 

keep the organization of the system at a manageable level, these temporary files should 

be deleted as necessary.  The suggested life-span of the temporary files will be: 1) raw 

data products (for both standard and non-standard processing) – 3 months, and 2) 

temporary data products (that result from data analysis procedures) – 1 month.  The raw 

data products are easily identifiable as they have the *.hdf file extension.  A regular 
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examination of the file folders will be necessary to identify the files, and they may then 

be deleted if they exceed the life-span criteria.  The temporary data products resulting 

from data analysis procedures will be identifiable only by the personnel who are 

conducting the exploratory data analysis.  It is their responsibility to make the judgment 

concerning the files that are necessary to maintain. 

 

Different standard products will have varying schedules for transfer to the AKRO data 

file server (X: drive) for archiving.  Images for each product should be copied to the 

AKRO data file server after the raw products have been mosaicked and reprojected to the 

Albers Conical Equal Area (Alaska Albers) projection.  Products from the Data Pool will 

be downloaded and pre-processed within several weeks of initial satellite acquisition and 

will be inserted into their appropriate directories at that time.  Files recording annual or 

seasonal metrics such as vegetation, snow or ice phenology will be transferred to the 

AKRO data file server annually.  Original raw data and interim processing products will 

not be archived by SWAN.  The raw data are archived by the EOS Data Gateway, and if 

necessary, can be retrieved and processed with procedures in Appendix 3.   

 

Non-standard products will be archived on the AKRO data file server in their appropriate 

product type directories.  Daily and composited images of surface reflectance will be 

archived after mosaicking and reprojecting into Albers Conical Equal Area (Alaska 

Albers) projection.  Key downstream products will also be archived, including 

accompanying metadata that documents the procedures used to analyze and interpret the 

images.   

 

 

4-4. Backup Procedures   

 

System backups are managed by the Alaska Regional Information Technology staff as 

described in the SWAN Data Management Plan, Section 11.5.  Additional backups of 

working documents, etc. may be performed by SWAN staff as needed.  
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SOP 6:  Changes to SOP 

 

 
Satellite-Derived Measures of Landscape Processes 

Southwest Alaska Network 

  

Standard Operating Procedure (SOP) # 6 

 

Changes to SOPs 

 
 

Revision History Log: 
Previous 

Version # 

Revision 

Date 

Author Changes Made Reason for Change New 

Version # 

      

      

      

      

      

 

 

This Standard Operating Procedure outlines the documentation of changes to the protocol 

narrative and accompanying SOPs.  Anyone editing the protocol narrative or any one of 

the SOPs must follow these procedures, as indicated by Oakley et al. (2003).   

 

Revision Procedures: 

 

1. All edits will require review for clarity and technical soundness.  Small changes or 

additions to existing methods will be reviewed by SWAN staff.  However, if a 

complete change in methods becomes necessary, an outside review will be required.  

Regional and national NPS staff with expertise in remote sensing and data analysis, 

and/or external specialists, will be utilized as reviewers.  

  

2.  Edits to the protocol will be tracked in the Revision History Log that accompanies the 

protocol narrative and each SOP.  Version numbers assigned to each edited draft 

should reflect the magnitude of changes therein:  major changes will be designated by 

whole number increases (e.g., Version 1.0 to Version 2.0, etc.) and minor changes by 

tenths (e.g., Version 1.1 to Version 1.2, etc.).  With each round of changes to the 

protocol narrative or SOPs, the following information should be recorded in the 

associated Revision History Log:  the previous version number, new version number, 

date of revision, author of the revision, paragraph(s) and page(s) where changes 

appear, and the rationale for each change. 

 

3.  The Data Manager must be informed regarding changes to the protocol narrative or 

SOP so that the new version number can be incorporated in the metadata of the project 

database.  The database may have to be edited by the Data Manager to accompany 

changes in the protocol narrative and SOPs. 
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4.  The Data Manager will post new versions of the protocol on the internet and notify via  

e-mail individuals known to have a previous version. 

 

5.  MODIS data production experiences infrequent changes in the “collection” or version  

number, as production algorithms are modified.  When these changes occur, the 

NASA philosophy is to re-process the entire data collection, dating back to February, 

2000.  However, when these reprocessing events occur, in some cases the reprocessed 

data are no longer comparable to the older (existing) version.  When this occurs, 

SWAN personnel should consult with the producers of this protocol to determine a 

strategy for continuous updating of the databases that are a result of this protocol. 
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Appendix 1:  Albers Projection Parameters and Spatial Subset for the SWAN 

 

 

Alaska Albers Conical Equal Area:  

 

Units:   Meters 

Datum:  NAD83 

Parameters: 

Central Meridian -154.0 

Latitude of Origin     50.0 

1
st
 Standard Parallel     55.0 

2
nd

 Standard Parallel     65.0 

 

 

 

Spatial Subset for the SWAN: 

 

Upper Left:  62.0 Latitude , -160.0 Longitude 

Lower Right:  56.0 Latitude , -146.0 Longitude  
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Appendix 2:  Example of Metadata for MODIS Calibrated Radiance Images  

 

Identification_Information: 

  Citation: 

    Citation_Information: 

      Originator: NPS, Southwest Alaska Monitoring Network 

      Publication_Date: Unpublished Material 

      Title: MODIS Calibrated Radiance Images for Southwest Alaska  

      Geospatial_Data_Presentation_Form: remote-sensing image 

      Online_Linkage: \\IFW7NR-NPSTEMP\I$\\SWAN\MODIS_CalRad\ 

      Larger_Work_Citation: 

        Citation_Information: 

          Originator: Reed B, Budde M, Spencer P, Miller A. 

          Publication_Date:  December 15, 2006 

      Title: Satellite-Derived Measures of Landscape Processes Monitoring Protocol for        

    the Southwest Alaska Network 

 

  Description: 

    Abstract: 

MODIS Calibrated Radiance products for the Southwest Alaska Network (SWAN) are created from 

MOD02 MODIS data available through the LAADS (Level 1 and Atmosphere Archive and Distribution 

System) at NASA Goddard Space Flight Center.  These images are used to monitor landscape-scale 

processes across the SWAN region.  Swaths for the SWAN region are downloaded from the LAADS 

website (http://ladsweb.nascom.nasa.gov/), mosaicked and reprojected to Albers Conical Equal Area 

(Alaska Albers).  Band numbers and corresponding wavelengths are: 

      Band                 

      1    620 -  

      2 841 - 876  

  

 

    Purpose: These images were created to provide large spatial scale, fine temporal scale data for the 

SWAN vital signs monitoring program. 

  Time_Period_of_Content: 

    Time_Period_Information: 

      Range_of_Dates/Times: 

        Beginning_Date: February, 2000 

        Ending_Date: present 

    Currentness_Reference: ground condition 

  Status: 

    Progress: In work 

    Maintenance_and_Update_Frequency: Continually 

  Spatial_Domain: 

    Bounding_Coordinates: 

      West_Bounding_Coordinate: -160 

      East_Bounding_Coordinate: -146 

      North_Bounding_Coordinate: 62 

      South_Bounding_Coordinate: 56 

  

 Keywords: 

    Theme: 

      Theme_Keyword_Thesaurus:  none 

      Theme_Keyword:  Inventory and Monitoring Program 

      Theme_Keyword: MODIS images 

      Theme_Keyword: Calibrated Radiance 

      Theme_Keyword: Landscape Processes 

     Theme_Keyword: monitoring 
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Theme: 

     Theme_Keyword_Thesaurus: ISO 19115 Topic Category 

 Theme_Keyword: Imagery 

Place: 

      Place_Keyword_Thesaurus: National Park System Unit Name Thesaurus 

Place_Keyword: Alagnak Wild River  

 Place_Keyword: Aniakchak National Monument and Preserve 

Place_Keyword: Katmai National Park and Preserve 

Place_Keyword: Kenai Fjords National Park  

       Place_Keyword: Lake Clark National Park and Preserve 

 Place_Keyword: Southwest Alaska Network 

Place: 

 Place_Keyword_Thesaurus: National Park System Unit Code Thesaurus 

Place_Keyword: ALAG  

 Place_Keyword: ANIA 

 Place_Keyword: KATM 

 Place_Keyword: KEFJ 

 Place_Keyword: LACL 

 Place_Keyword: SWAN 

Place: 

      Place_Keyword_Thesaurus: none 

      Place_Keyword: Katmai 

      Place_Keyword: Lake Clark 

      Place_Keyword: Kenai Fjords 

      Place_Keyword: Aniakchak 

      Place_Keyword: Southwest Alaska 

      Place_Keyword: Kenai Peninsula 

      Place_Keyword: Kodiak 

      Place_Keyword: Alaska Peninsula 

      Place_Keyword: Cook Inlet 

      Place_Keyword: Naknek Lake 

      Place_Keyword: Tustemena 

      Place_Keyword: Skilac 

      Place_Keyword: Beluga 

      Place_Keyword: Chakachamna 

      Place_Keyword: Twin Lakes 

      Place_Keyword: Susitna Valley 

      Place_Keyword: Bristol Bay 

      Place_Keyword: Kvichak Bay 

      Place_Keyword: Kujulik Bay 

      Place_Keyword: Shelikof Strait 

      Place_Keyword: Becharof 

      Place_Keyword: Southcentral Alaska 

      Place_Keyword: Lake and Peninsula Borough 

      Place_Keyword: Kodiak Island Borough 

      Place_Keyword: Kenai Peninsula Borough 

      Place_Keyword: Becharof National Wildlife Refuge 

      Place_Keyword: Kodiak National Wildlife Refuge 

      Place_Keyword: Alaska Peninsula National Wildlife Refuge 

      Place_Keyword: Prince William Sound 

      Place_Keyword: Anchorage 

      Place_Keyword: Port Alsworth 

      Place_Keyword: Kenai 

      Place_Keyword: Homer 

      Place_Keyword: Seward 

      Place_Keyword: King Salmon 

      Place_Keyword: Port Heiden 
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      Place_Keyword: Port Moller 

      Place_Keyword: Chignik 

      Place_Keyword: Dillingham 

      Place_Keyword: Karluk 

      Place_Keyword: Naknek 

      Place_Keyword: Egegik 

      Place_Keyword: Ugashik 

      Place_Keyword: Pilot Point 

      Place_Keyword: Iliamna 

 

  Access_Constraints: none 

  Use_Constraints: none 

  Point_of_Contact: 

    Contact_Information: 

      Contact_Person_Primary: 

        Contact_Person: Page Spencer 

        Contact_Organization: NPS, Alaska Regional Office 

      Contact_Position: Ecologist 

      Contact_Voice_Telephone: 907-644-3448 

      Contact_Electronic_Mail_Address: Page_spencer@nps.gov 

  Native_Data_Set_Environment: Microsoft Windows XP Version 5.1 (Build 2600) Service Pack 2; ESRI 

ArcCatalog 9.0.0.535 

Data_Quality_Information: 

  Attribute_Accuracy: 

    Attribute_Accuracy_Report: Spectral accuracy within limits of MOD02 processing  

  Positional_Accuracy: 

    Horizontal_Positional_Accuracy: 

      Horizontal_Positional_Accuracy_Report: within 300 m    Vertical_Positional_Accuracy: 

      Vertical_Positional_Accuracy_Report: NA 

 

  Lineage: 

    Process_Step: 

      Process_Description: Complete processing of these images is documented in the Protocol for Satellite-

Derived Measures of Landscape Processes.  Calibrated Radiance images are the MOD02 MODIS data 

generated by NASA Goddard .  The images in the SWAN archive are derived from V005 processing, 

initiated by NASA Goddard in fall 2006.  All MODIS acquisitions are being reprocessed as V005.  MOD02 

granules over SWAN are acquired from theLAADS, mosaicked and reprojected using the MODIS Swath 

Reprojection Tool. 

      Process_Date: varies, updated continuously 

  Cloud_Cover: varies 

 

Spatial_Data_Organization_Information: 

  Direct_Spatial_Reference_Method: Raster 

  Raster_Object_Information: 

    Raster_Object_Type: Pixel 

    Row_Count: 2783 

    Column_Count: 3483 

    Vertical_Count: 1 

Spatial_Reference_Information: 

  Horizontal_Coordinate_System_Definition: 

    Planar: 

      Map_Projection: 

        Map_Projection_Name: Albers Conical Equal Area (Alaska Albers) 

        Albers_Conical_Equal_Area: 

          Standard_Parallel: 55.000000 

          Standard_Parallel: 65.000000 

          Longitude_of_Central_Meridian: -154.000000 
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          Latitude_of_Projection_Origin: 50.000000 

          False_Easting: 0.000000 

          False_Northing: 0.000000 

      Planar_Coordinate_Information: 

        Planar_Coordinate_Encoding_Method: row and column 

        Coordinate_Representation: 

          Abscissa_Resolution: 250.000000 

          Ordinate_Resolution: 250.000000 

        Planar_Distance_Units: meters 

    Geodetic_Model: 

      Horizontal_Datum_Name: North American Datum of 1983 

      Ellipsoid_Name: Geodetic Reference System 80 

      Semi-major_Axis: 6378137.000000 

      Denominator_of_Flattening_Ratio: 298.257222 

 

Distribution_Information: 

  Distributor: 

    Contact_Information: 

      Contact_Organization_Primary: 

        Contact_Organization: NPS Southwest Alaska Monitoring Network 

      Contact_Position: SWAN Data Manager 

      Contact_Address: 

        Address: 240 W 5th Ave 

        City: Anchorage 

        State_or_Province: AK 

        Postal_Code: 99501 

        Country: USA 

      Contact_Voice_Telephone: 907-644-3684 

 

  Resource_Description: SWAN Server:\SWAN\MODIS_CalRad\ 

  Distribution_Liability: 

The National Park Service shall not be held liable for improper or incorrect use of the   data described 

and/or contained herein. These data and related graphics (i.e. "GIF or JPG" format files) are not legal 

documents and are not intended to be used as such. The information contained in these data is dynamic and 

may change over time. The data are not better than the original sources from which they were derived. It is 

the responsibility of the data user to use the data appropriately and consistent within the limitations of 

geospatial data in general and these data, as outlined in  particular. The related graphics are intended to aid 

the data user in acquiring relevant data; it is not appropriate to use the related graphics as data. The 

National Park Service gives no warranty, expressed or implied, as to the accuracy, reliability, or 

completeness of these data. It is strongly recommended that these data are directly acquired from an NPS 

server and not indirectly through other sources which may have changed the data in some way. Although 

these data have been processed successfully on computer systems at the National Park Service, no warranty 

expressed or  implied is made regarding the utility of the data on other systems for general or scientific 

purposes, nor shall the act of distribution constitute any such warranty. This disclaimer applies both to 

individual use of the data and aggregate use with other data. 

 

  Standard_Order_Process: 

    Digital_Form: 

      Digital_Transfer_Information: 

        Format_Name: TIFF 

        Transfer_Size: 18.510 

    Fees: none 

Metadata_Reference_Information: 

  Metadata_Date: 20051205 

  Metadata_Contact: 

    Contact_Information: 

      Contact_Person_Primary: 
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        Contact_Person: Page Spencer 

        Contact_Organization: NPS, Alaska Regional Office        

Contact_Address: 

        Address_Type: 240 West 5
th

 Avenue 

        City: Anchorage 

        State_or_Province: Alaska 

        Postal_Code:  99501 

      Contact_Voice_Telephone: 907-644-3448 

  Metadata_Standard_Name: FGDC Content Standards for Digital Geospatial Metadata 

  Metadata_Standard_Version: FGDC-STD-001-1998 

  Metadata_Time_Convention: local time 

  Metadata_Extensions: 

    Online_Linkage: http://www.esri.com/metadata/esriprof80.html 

    Profile_Name: ESRI Metadata Profile 
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Appendix 3:  Grid data for Surface Reflectance Processing 

 

 

Revision History Log: 

Previous 

Version # 

Revision 

Date 

Author Changes Made Reason for Change New 

Version # 

      

      

      

      

      

 

This Appendix explains the procedures for browsing, acquiring and processing MODIS 

surface reflectance images that are not included in the procedures outlined in SOPs 2-4.    

Surface reflectance (MOD09) products are processed to remove the effects of the 

atmosphere so that multiple dates of images can be directly compared with each other.  

An aerosol correction is applied to remove variations due to water vapor, particulates and 

smoke.  MOD09 data are projected into geographic tiles which can be mosaicked into the 

area of interest.    

 

A3.1. Data Browse   

 

There are several browse facilities for MODIS data.  The easiest one to use is the 

Rapidfire site maintained by NASA Goddard: 

http://rapidfire.sci.gsfc.nasa.gov/production/.  

 

Browse the thumbnails and select desired dates and locations as described in SOP 4.1. 

A3.2. Data Order   

Order through the EOS Data Gateway (http://LPDAAC.usgs.gov/main.asp) 

a. On the left side of the window:  Data Access box, select EOS Data Gateway 

b. At the screen for the “Earth Observing System Data Gateway:, register yourself 

as a User.  This will (usually) make ordering faster since they will have a record of 

your address and other such data.) After the first time, enter as a registered user. 

c. On the left side of the “Primary Data Search” window:  Search and Order box, 

select Search Creation 

d. You will have the “Choose Keywords for One or More Categories” screen.  

You will use this to choose the desired data products and the spatial tiles that cover 

the SWAN region. 

 Choose Data Sets 

a. Select “By Categories/Attributes” button 

b. Highlight “Data Set” and press the “Choose Keywords for>>” button 

c. The screen for “Keyword Selection:  Data Set” appears.  In the window 

for “Data Set list 3:” highlight the desired data sets.  This window allows 

you to select both Aqua and Terra data sets.  Select the V004 data sets 

when available.  You can select surface reflectance daily or multiple-day 

composites, snow products and Vegetation Indices  

d. MOD09 products are listed as: 

http://rapidfire.sci.gsfc.nasa.gov/production/
http://lpdaac.usgs.gov/main.asp
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MODIS/Aqua  (or Terra) Surface Reflectance Daily L2G Global 250m 

SIN GRID V004 

e. After selecting desired data sets, click OK!  This returns you to the “Choose 

Keywords for One or More Categories.  Your selected data sets should be 

displayed in the Data Set window. 

 Choose Spatial Area by tile  

1. Return to choose keywords window and select “spatial”, which is at the 

bottom of the list.  Click on “Choose Keywords for>>” 

2. A new screen appears asking for tile numbers: 

SWAN tile numbers are:  Horizontal 9, 10 and 11 and     

Vertical 2 and 3 

Fill these in and press OK (Fig A3.1). 

Figure A3.1.  Selecting spatial search area by tile. 

 Choose A Data Search Type:  select “Primary Data Search”  

At this point the upper part of your search window should look similar to Fig. 

A3.2: 
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Figure A3.2.  Primary data search window.   

 

 Choose Date/Time Range 

 

Enter desired date(s) by standard date nomenclature or Julian date ranges.  

Remember if you are searching for multi-date composites that the date you will 

enter is the first date in the time series (Fig A3.3.). 

 

Figure A3.3.  Selecting Date/Time range for data search. 
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3.  Press “Start Search”  

4. The “Search in progress” screen appears to track the search progress.  

When completed, a “Listing” screen appears with each file displayed.  

Click a check mark in the selection box of each file you want.  In the 

example below, a search was done for the 250 meter surface reflectance 

data (MOD09GQK) for SWAN tiles for Julian day 308, 2005.  I have 

selected the six SWAN tiles for day 308 (November 4, 2005).  After 

selection is finished, press “Add selections to cart” (Fig A3.4). 

Figure A3.4.  Selecting tiles and adding to cart. 

5. The “Data Quality Summary” page appears.  Run to bottom of screen and 

click the “Accept-Continue to Shopping Cart” button. 

6. The shopping cart contents are displayed on the screen labeled “Step 1:  

Choose Ordering Options” 

Click the yellow box in front of the top file box that says “ordering 

options”.  The “Choose Ordering Options” screen appears.  Select the 

button near the bottom, which reads “FtpPull” in the Media type column.  

Be sure the top button for “I want these ordering options for every data 

granule….” is marked.  Click “OK! Accept my choice and return to 

shopping cart!” (Fig A3.5).  
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Figure A3.5.  Choosing ordering options. 

7. This returns you to the Step 1 screen.  Each file should have an order 

option of FtpPull in the left column.  Press “Go to Step 2:  Order Form” 

If you are a registered user, the Step 2:  Order Form screen should be filled 

out for you.  If you are working as “Guest”, you will have to fill out the form.  

When finished, press “Submit Order Now!” 

8. The “Order in Progress” screen appears, followed by the “Order 

Submitted” screen.  If all goes well, you should get an email soon from edc 

that verifies your order.  A second email will be sent within minutes to hours, 

depending on the size of your order and the workload at the EOS gateway.  

Save the second email (from CM SHARED (CM Code Delivery) because it 

has the instructions for the data download. 

A3.3. Data Download 

d. You will need ftp software to get your data from the LP DAAC.  Either 

use the regular FTP command that comes with Windows, or download one 

you prefer.  .  DO NOT USE WINDOWS COPY and PASTE 

commands—it takes a long time and the connection will often time out.   



12/15/06  Satellite-Derived Measures of Landscape Processes  

Protocol Narrative - Version 1.00   

137 

 

e. When the email comes from CM SHARED, look near the bottom of the 

second page below the line of +++++s.  You need the FTPHOST and the 

FTPDIR lines: 

++++++++++ 

 

ORDERID: 0300371885 

REQUESTID: 0300557018 

USERSTRING:  

FINISHED: 11/22/2005 19:24:09 

 

MEDIATYPE: FtpPull 

MEDIAFORMAT: FILEFORMAT 

FTPHOST: e0dps01u.ecs.nasa.gov 

FTPDIR: /PullDir/0300557018nwGIFA 

f. Open a DOS Command window:  StartAll 

ProgramsAccessoriesCommand Prompt 

Change (cd) to the directory on your computer where you want to save 

your files 

Example:  > cd  {name of directory} 

Note: For help using DOS, type “help” at the > prompt, and a list of 

commands will appear.  The command cd  .. will take you up up a level in 

the directory tree structure, and that cd pathname will take you down or 

across the directory tree structure. 

 

ncftp to the FTPHOST site: 

Example:  ncftp e0dps01u.ecs.nasa.gov 

cd to the FTPDIR 

Example:  cd /PullDir/0300557018nwGIFA 

Dir to list files.  There should be two files for every tile you ordered:  a 

*.hdf file and a *.hdf.xml file. 

get all the files: 

Example:  mget *.* 

g. The files will start downloading.  The ETA: counter shows approximate 

time remaining for that file.  This process can take a long time.  If a 

connection is fast, you may get them within an hour..  This is a good thing 

to do at the end of the day.  DO NOT CLOSE the DOS WINDOW!  If all 

goes well and the connection doesn’t break, you should have your files by 

the next day (Fig A3.6).   
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Figure A3.6.  FTP Download of LPDAAC data. 

A3.4. Data Processing 

A3.4.1. Mosaic and Reproject the tiles into a geometrically corrected image of the 

SWAN Region. 

 

You will need the MODIS Reprojection tool (MRT) for this step.  Download the MRT 

from the EROS LP DAAC page:  http://LP DAAC.usgs.gov/main.asp and install it on 

your machine using the handy “User’s Manual”.  See SOP # 1 for further details about 

installing the software.  NOTE—don’t use any spaces in your paths or filenames or this 

software will not work. 

 

Run the MRT using the shortcut you created during installation.  A black window labeled 

ModisTool.bat comes up, quickly followed by the ModisTool GUI.  Fill out the GUI 

screen as follows: 

 

1) Open Input File  --  browse to the directory where you saved the downloaded tile 

files (hdf files).  Select the desired tiles.   

2) The Input File Info box is populated by the MRT.  All the bands in your hdf tile files 

are displayed in the “Selected Bands” box on the right.  Put the files you DON’T 

want over in the “Available Bands” box on the left by selecting them and pressing the 

<< button.  You should keep the bands labeled xxx_b01_, xxx_b02_, up to xxx_b07_.  

http://lpdaac.usgs.gov/main.asp
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These bands are the spectral data, and the b# corresponds to the band number of the 

MODIS sensor.  See http://LPDAAC.usgs.gov/modis/table2.asp or Table 1 in the 

Protocol Narrative for a listing of band numbers and their corresponding wavelength 

ranges. 

3) Spatial Subset:  Input lat/long 

UL corner is 62 latitude, -160 longitude 

LR corner is 56 latitude, -146 longitude 

4) These are the boundaries of the SWAN region.   

5) Specify Output File:  browse to directory where you are putting projected files and 

specify file name.  Be sure to add the .tif to the filename.  The MRT will add the band 

number and product type to whatever you specify as a root file name. 

6) Output file type is GEOTIFF 

7) Resampling Type is Nearest Neighbor 

8) Output Projection Type is Albers Equal Area 

9) Edit Projection Parameters: 

SMajor : 0.0  SMinor : 0.0  STDPR1 : 55.0 

STDPR2 : 65.0 CentMer : -154.0 OriginLat : 50.0 

FE : 0.0  FN : 0 .0  Datum : NAD83 

10) Output pixel size is whatever you ordered (250m, 500m or 1000m) 

 

Press Run button.  A Status window appears and tracks the processing for each band.  

Mosaicking is done first, followed by reprojecting.  The MRT writes the final files to the 

directory and name specified in the Output File window.  You will have a geotif image 

for each spectral band you specified in the Selected bands window (Fig A3.7). 

http://lpdaac.usgs.gov/modis/table2.asp
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Figure A3.7.  MRT Graphical User Interface for data processing. 

A3.5. Composite single band images into multi-band image and enhance for manual 

interpretation.   
This step uses ENVI software to stack the images into a single file.  You can use ENVI 

for further enhancing, or export a tif file for enhancing with a package such as Photoshop.  

Using ENVI retains the geographic location capability, so the image can be used in 

various GIS or further image analysis functions.  Using Photoshop creates a color image 

where the red/green/blue channels are no longer spectral data, but simply color values of 

a picture.  Use Photoshop to pretty up a picture for simple interpretation, posters or 

publications where the actual spectral data values are no longer needed. 

Open ENVI 
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1. (in the Main ENVI menu) Fileopen image file.  Select desired bands 

from geometrically corrected list.  Display as natural color or false color 

infra-red composite.  Natural color can be done using the 500m or 1000 m 

data with seven bands.  CIR can be created using the two bands in 250m 

data, or the seven band data.  Specify appropriate bands from the available 

bands list and load RGB. 

Natural color  

Red gun band 1 

Green gun band 4 

Blue gun band 3 

Color Infra red  

Red gun band 2 

Green gun band 1 

Blue gun band 4  (or repeat band 1 with 250m data) 

2. (in the Main ENVI menu) FileSave file asENVI standard  The 

ENVI standard file will be a flat binary file with an associated header file 

(*.hdr).  Stack as many bands in the file as you will want to work with.  If 

working with the 250m data, which has only two bands, you can duplicate 

band one to give an easily displayed CIR image.  Your resultant file will 

be a multi-band image of the SWAN Region.  You can use this to proceed 

with ENVI processing, including various stretches and other 

enhancements.   

3. (In the Display Image Menu)  Enhance    Using the scroll window 

as the target, the preprogrammed stretches for Linear 2% and the Square 

Root make a quick and often useful enhancement.  Another useful 

enhancement is in the Main ENVI Menu:  TransformPhotographic 

Stretch.  This stretch has cleaned up images with several “foggy” bands 

and results in a clean appearing image.   

 

For finer tuning of specific features, use the interactive stretching at the 

bottom of the menu.  In the histogram window menu:   

Stretch_TypePiecewise Linear 

Add nodes to the white stretch line in the histogram with the middle 

mouse button 

OptionsEdit Piecewise Linear 

Enter new (output) values for each node in the right column (LUT Val) 

 

4. If you want a picture to work with in Photoshop or other graphics 

packages, Powerpoint or documents, you need to export the file in a 

format those packages can utilize.   

 

Right mouse click in the display window.  In the resultant window, select 

“Save image as”.  Under “Output File Type, select desired format (tif, 

bmp, jpg ).  You can open the resultant picture in Photoshop and use the 

Image Adjustments functions to enhance the color balance, brightness and 
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contrast.  Photoshop is also a good place to add non-geographic graphics 

and some text and create quality output products. 

 

A3.6. Creating an image of the entire state of Alaska 

 

1.  Data Order.  When specifying the spatial tiles for a data search and order, collect all of 

the following tiles.  You may need to conduct this part of the search more than once and 

add them to your order incrementally. 

h06v03                h11v02  

h07v03                h11v03  

h08v03                h12v01  

h09v02                h12v02  

h09v03                h12v03  

h10v02                h13v01  

h10v03                h13v02  

h28v03     h29v03 

 

2.  Data reprojection and tile mosaicking:  When mosaicking and reprojecting the tiles, 

you will need to do it in three pieces and mosaic them together in ENVI or display them 

together in ArcMap. 

H06 through h13 all projected into one piece east of the -180 longitude (date line). 

H28v03 in a separate piece west of 180 longitude 

H29v03 in another separate piece west of 180 longitude 

 

When you process the big set of tiles east of the dateline (H06-H13) in the MODIS MRT, 

do NOT specify a spatial subset.  Let it default to the full extent of the tiles.  Use the 

usual parameters for editing the projection parameters.  This should result in a large file 

for mainland Alaska plus the eastern Aleutians, and two smaller files for the western 

Aleutians for every band you process. 

 

3.  Mosaicking of three subimages.   

In ENVI—at main menu 

Basic ToolsMosaickingGeoreferencedImportImport files and edit 

properties 

Select or browse to your mainland image.  After it displays in the little image 

window, select another smaller file.  Then the last one.  They should each display 

in the mosaicking window.  Be sure to keep the same spectral stretch for all three 

files.  Use the appropriate value for background pixels to set to transparent so you 

don’t have black patches in your mosaic.   

Then go to Fileapply in the mosaicking window.  Specify an output image 

name.  

Proceed to display and stretch and marvel at the image as you have been doing 

with SWAN images.   

If you don’t need to have the image all in one big file, you can go into ArcMap and load 

all three files.  They will be displayed in the correct relative position, but they are still 

three separate pieces.  However, you can overlay vectors on them and create useful maps. 
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